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1. Introduction 

1.1. Revision history 

Rev Date Description 

1.1 01.05.2018 First edition 

1.2 01.10.2018 Second edition – reference to iSMA Tool ver. 1.1.1 

1.3 06.12.2018 Third edition – updated for iSMATool rev. 1.2.0 

1.4 21.01.2019 Fourth edition – updated for iSMATool rev. 1.2.1 

1.5 24.07.2019 Fifth edition – updated for iSMATool rev. 1.2.2 
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2. iSMA Tool Concept 

As a significant part of end-to-end iSMA solution, iSMA Tool gives customer a convenient way 

to create and manage custom applications for Sedona-based iSMA controller. 

iSMA Tool now covers all needs one could have to create a perfect application: wire sheet for 

convenient visual programming, Property sheets for details, kit management, real time 

monitoring of system states and slot values, logs and historical data, deployment and backup. 

Future releases will offer support for visual dashboards, cover growing controllers family, 

simulators, new protocols, firmware management, even more usability improvements. 

2.1. About iSMA Tool 

iSMA Tool allows programming, parameter setting and building of applications in iSMA-B-

AAC20 controller. Using proper functions implemented in iSMA Tool, the User can build his 

own application “from scratch” or edit an existing application working directly on a connected 

device. 

iSMA Tool is addressed to every User working daily with iSMA-B-AAC20 controllers, i.e. 

distributors, integrators, engineers and maintenance technicians.  

iSMA Tool is compatible with devices manufactured by Global Control 5 Sp. z o. o.  Working 

with devices manufactured by third parties and programming them is not possible. There is a 

possibility of unlocking iSMA Tool for a select customer including handling of additional 

controllers. For this purpose Global Control 5 support needs to be contacted (email: 

support@gc5.pl). 

Eventually iSMA Tool will eliminate the need for any other GC5 programs, including “FCU 

Updater”, “Sedona Updater”, or “iSMA Configurator”. Functionalities of the above applications 

will become a part of iSMA Tool system. 

2.2. Naming and its definition 

A proper understanding of the terms used hereafter will allow iSMA Tool User to adopt the 

described issues in a more proficient way. The names of the terms listed below will be written 

with a capital letter.  

● iSMA Tool - the name of computer program this document applies to. 
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● Component - a single element of an application working in SVM (Sedona Virtual Machine) 
environment. A Component may be a function block with a pre-defined task - algorithm 
and requires specific parameters and logical connections with other Components to work 
and exchange data properly. It can also be a container - folder to segregate other 
Components. 

● Kit - a set of Components with similar functionality or working in the same area, e.g. 
Components handling controller’s inputs and outputs. In iSMA Tool Kits and their 
Components are shown in Device Kits window. 

● Link – logical connection between Components. This connection allows two Components 
to send data between each other. The graphical representation of a Link in Wire Sheet view 
is a line connecting Components. 

● Slot – a Component element defining the parameter along with its name, value, unit and 
range. Each Component has a Slot named “Meta” and a number of other editable or read-
only parameters made available to the user called the Slots. Slots aren’t visible in all views, 
to avoid overwhelming the User with too much information. The views dedicated to work 
with Slots are: Property Sheet, Slot Sheet and Wire Sheet. 

● Selection – a state of choosing with a click of a mouse of any Component or Link by the 
User. The chosen object becomes highlighted graphically. In Wire Sheet view the selection 
is illustrated by surrounding a Component with an orange frame. Link selection - by 
changing its colour to orange. The selected element is an object to which the commands 
will relate, such as copying, deleting or moving. 

● Marking – a state relating to Component or Link, connected with the selected object. 
Marking means that a specific Component or Link is in correlation with a marked 
Component/Link. In Wire Sheet view a green colour is used to mark Component and Link, 
which allows the User to easily notice which Component/Link will need his attention, e.g. 
after deleting a marked Component/Link.  

● Workspace Window – one of the basic windows provided by iSMA Tool. That window 
shows the devices along with their Components. Additionally, the devices may be assigned 
hierarchically to folders, and folders to projects.  

● Device Kits – one of the basic windows provided by iSMA Tool. It is a Kit library along with 
Components assigned to them. The content of Kits is dynamically adjusted to the type of 
connected device. 

● Main screen – the main workspace of iSMA Tool. It is a window where the views of an 
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editable Component are shown on tabs.  

● Object Properties Window – window showing information regarding selected element 
allowing to preview and change some of selected element’s parameters without closing 
the current view. 

● Console – a window, where iSMA Tool sends messages regarding application operation 

 

Component Views 

Component shows its data on views assigned to it. A list below shows four basic views, which 

present data about the same Component in different ways, making the work with Component 

easier. Some Components, such as component showing historical data as graphs or 

component allowing the creation of complex work schedules, apart from standard views have 

also individual ones, which aren’t included in the list below. 

● Wire Sheet – a view showing programming relations between Components in a graphical 
way. This view shows logical relations between Components connected with Links. This 
view makes building application logic easier, because the connections between 
Components are easy to enter and analyse. It is the view most commonly used by 
programmers on the application programming stage. 

● Property Sheet - it is a tabular form showing parameters - Component Slots. The User can 
see not only the Slot value, but also its units and range. This view allows the Slot value 
change, if the Slot has value change rights. Property Sheet is often used at the start-up 
stage, when the settings of many parameters (Slots) in Components need to be set. 

● Slot Sheet – a Component view showing all Slots, including the hidden ones. In a tabular 
form it allows to read the name, type and parameters (Facets) of the Slot. 

● Link Sheet – a Component view that allows for checking what other Components and their 
Slots are connected to the component viewed in tabular form. Link Sheet is used when we 
want to check if the required Slots have been connected to other Components, i.e. when 
we want to make sure that we have not missed any connection. Mainly, developers use 
this view to verify their control algorithm. 
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3. iSMA Tool Installation 

iSMA Tool is a software created for modern Microsoft Windows system, such as Windows 10. 

The oldest supported version of the operating system is Windows 7. iSMA Tool is delivered as 

a compressed folder, which needs to be extracted in a chosen location and hard drive, unless 

the access to the extracted folder is restricted by the system (e.g. “Program Files” is not a 

recommended location).   

The extraction provides the folders and additional files described below . One of the files is 

“iSMATool.exe”, used to run iSMA Tool.  

 

The extracted folders serve the following functions: 

● Config - a folder containing a record of user’s individual settings regarding window location 
and other iSMA Tool work settings, such as the language chosen for iSMA Tool interface.  

● home - a folder, where all the data created by user are saved, i.e. device backups, 
applications, etc. It’s also a folder, where  Kits library, available in iSMA Tool, is located. 

● icons - a folder with graphical files such as iSMA Tool interface icons. 

● Localization - a folder with text files responsible for iSMA Tool’s multilingualism. 

● log - a folder, where logs of iSMA Tool, which also appeared in Console window, are saved. 
When contacting GC5 technical support, it is advised to copy the last file with logs form 
that folder 

● de, es, ja, Resources, ru – are folders with system libraries. 

 

To properly install and work with iSMA Tool the User's computer must meet the following 

minimal requirements:  
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● Processor (CPU): Intel Core i3-3xxx or equivalent;  

● Memory: 4GB RAM;  

● Storage: 50 GB internal hard driver;  

● Ethernet 100 Mbit or 1Gbit NIC;  

● MS Windows 7 (recommended MS Windows 10); 

● .NET Framework 4.6.2 or higher 

 

WARNING! When iSMA Tool is run for the first time, you will be asked to accept EULA licence. 

Only accepting the licence will allow you to run the program. Lack of acceptance closes iSMA 

Tool. 

Note: For iSMA Tool to work properly it needs to be run periodically, at least once a month, on 

a computer connected to Internet for about an hour, depending on data transfer rate.  This will 

enable iSMA Tool to automatically download the latest data, such as Kits and updates. 

iSMA Tool is a portable software. It is “transferable” and can be installed on a portable data 
storage device such as USB memory stick. This allows iSMA Tool to be run directly from 
portable data storage device on any PC, including offline ones.  

 

3.1. iSMA Tool Updating 

iSMA Tool has an inbuilt mechanism notifying the User when a new version of the software is 

available on GC5 server. Every time iSMA Tool starts up and it has access to the Internet 

software checks the availability of a new version. If a new version is available, a pop-up widow 

similar to the one shown below will appear. 
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The handling of the window shown above is as follows: 

• “Yes” - allows downloading a new version of iSMA Tool by opening an appropriate 
location in User's default web browser. The new version of iSMA Tool needs to be 
downloaded (zip file) by saving it locally on computer’s hard drive and then extracted, 
overwriting the current iSMA Tool version.  

• “No” - closes the iSMA Tool new version notification window. The window will appear 
again after restarting iSMA Tool. 

• “Don’t inform me” – closes the window just as the previous option and turns off the 
iSMA Tool new version checking mechanism on program start up. The mechanism 
will remain turned off until it is manually turned on in iSMA Tool settings described in 
chapter ”10 – iSMA Tool Settings” 

WARNING! Before overwriting the current version of iSMA Tool the software needs to be 

closed and the User has to make sure that important data (kits, applications, settings) is saved 

in dedicated folders: “home” and “Config”. These folders will not be overwritten or deleted while 

extracting/overwriting the current iSMA Tool version with an updated one, preserving 

everything the User has created. 

The automatic checking mechanism described above may be turned on or off in iSMA Tool 
settings described in chapter “10 – iSMA Tool Settings”. When the checking mechanism is 
turned on and there are no new versions of iSMA Tool, the system will display an appropriate 
notification: “No updates for iSMA Tool” on the console. 

There is also a manual way of checking software updates availability. To do it the menu “Check 
updates”, available in upper “Help” menu, needs to be initiated. After initiating that option iSMA 
Tool will check the availability of new versions and display an appropriate notification. If a new 
update is available a pop-up window, described above, will appear.  
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4. iSMA Tool Windows 

When iSMA Tool is run for the first time an iSMA Tool application is displayed, consisting of a 

few windows shown on the picture below. 

 

The above look applies only during initial activation of iSMA Tool. Further activations and 

updates of iSMA Tool will remember the window settings changed by the User in accordance 

with his preferences.  

In the default setting of iSMA Tool, the upper left side of the screen is occupied by Workspace 

Tree window. Below is the Device Kits window showing current Kits of the connected device. 

Central part of the screen is occupied by the Main screen, a place where the application’s 

views will be shown on tabs, discussed further. After iSMA Tool activation the Main screen 

shows program information shown on the picture above. Under the Main screen there is a 

Console window, and on the right there is Object Properties window. 

Additionally, besides aforementioned windows, iSMA Tool screen shows menu and toolbar, a 

window with editable Component path and iSMA Tool capacity identifier. 

The window with editable Component path is by default set below the main menu and toolbar. 

It can be moved to the bottom, below the Console window, or even to the left, or right margin 

by changing the path text to the vertical one. 
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The suggested window position in iSMA Tool can be modified freely by dragging, decreasing 

and fixing views relative to each other. 

4.1. Window Adjustment 

iSMA Tool allows a completely free setting of the views and windows. Free distribution allows 

specific windows to be visible non-stop or hide automatically. These settings apply to 

windows such as: Workspace Tree, Device Kits, Object Properties, Console window. It is 

possible to move a window outside of iSMA Tool software to other connected screen. 

To move any window into another part of the screen it needs to be grabbed by the header and 

dragged into a new location. The picture below shows moving of the Object Properties 

window. During moving of the window special controls have appeared to help proper placing 

of the window in relation to the remaining windows of iSMA Tool. 

 

 

 

As a result of changing the window position in iSMA Tool it is possible to adjust their look 

according to individual needs. On the picture (below) the Console window has been moved 

above the Main screen. The Workspace Tree window has also been moved above the Main 
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screen on the following tab and the Device Kits window has changed its position from left side 

to the right. 

 

 

 

 

 

 

 

 

iSMA Tool offers a quick extension of the Main screen to the whole area thanks to automatic 
minimizing of the remaining windows. To temporarily enlarge the Main screen the arrow 
button on the toolbar under the main menu needs to be pressed as it is shown on the pictures 
below showing iSMA Tool before and after the enlargement of Main screen.  

 

 

 

 

 

Pressing the arrow again results in return to the previous setting.  
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5. Workspace Tree 

Workspace Tree, also known as project tree, is a window designed to work with devices. 

Thanks to a hierarchical structure of the tree it is easy to switch between the devices and their 

Components. It is also a place to add/remove the controllers and to manage Components. 

iSMA Tool Workspace Tree is designed to navigate the projects and devices defined for them. 

For each project it is possible to define any number of folders and any number of devices 

inside them. It is recommended that the structure of folders, subfolders and devices 

corresponds to their physical placement and/or logical subordination of controllers on an 

object. It will make finding a particular controller among a vast quantity of devices fast and 

easy. The structure of folders, subfolders and projects mentioned above allows to properly 

locate a specific controller in a Workspace Tree. A hierarchical structure inside the controller 

is loaded directly from controller and consists of Components. There are different controller 

Components, depending on services and functions offered by a specific device.  

Workspace Tree is being saved in “*.itw” file in a specified location. The User can save 

Workspace Tree under a defined name in a specific location. The “itw” (Workspace) file stores 

the whole structure of Workspace Tree including device names and their addresses. This 

allows to save many projects in one “itw” file or vice versa, each individual project in a separate 

“itw” file. 

A file with “itw” extension is a xml file and contains sensitive data, such as device IP addresses 

and their passwords, if the User issued a command to remember them. Due to obvious threat 

exposing of such data poses, iSMA Tool codes sensitive data automatically, preventing their 

exposition to third parties. 

An example window of Workspace Tree is shown on a picture below. 



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 16 / 129 

 

 

 

As one can see, there are two independent projects on Workspace Tree picture: “Site A” and 

“Site B”. Each project is a separate tree with folders and devices.  Devices (objects with IP 

numbers) were defined in folders specifying their location, such as e.g. “Basement” and 

“Floor2”, or “Antres” and “South Enter”. Folder “Antres” has been placed under the main folder 

- “Main Hall” for a better organization of controller position. 

Double-clicking on the device symbol allows to connect and show its contents, which is 

described in details further in this instruction. 
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5.1. Tree Elements Editing 

For folders, subfolders and main element - project, pressing the right mouse button provides 

the following options: 

 

• “New Project” - creating a new project independent of the others 

• “Add Folder” - adding folder under the selected folder 

• “Add Device” - opening the device adding window for the selected folder 

• “Remove” - removing the selected element: device, folder, or project from the tree 

 

iSMA Tool software supports UTF8 symbols in most of the places in the project. So it is 

possible to use native letters to lay out the project in a convenient way: 
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Please note though, that Sedona supports a very limited set of symbols for component 

names, so iSMA Tool will not allow to add one with non-ASCII name: 

 

 

 

WARNING! Removing the parent folder or project removes all that was under it, after operation 

confirmation. In the situation shown on the picture, removing the folder “South Enter” will 

result in removing the controller from the project, but the controller contents will not be 

deleted. 

Any name can be given to project, folder, or even device. For this purpose the object needs to 

be selected and the mouse clicked once more, or the function key F2 has to be used. 

On the Workspace Tree under a controller the device Components are shown, which can be 

used to build the application program. Due to hierarchical structure of the tree, if a selected 

element of the tree has other elements under it, i.e. children, issuing a command to a parent 

will involve all the subject elements, i.e. children, as well. This involves the “Delete” function as 

well - deleting the parent will delete all the children.  

It is possible to select many elements at once by using Ctrl or Shift key the same way as in 

Windows Explorer. 

WARNING! To save any modifications in Workspace Tree hierarchy or naming (not applicable 

to device tree) the Workspace Tree needs to be saved using “Save” or “Save as ...” option 

available in “File” menu or corresponding button in toolbar.  
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5.2. Connecting to a Device  

At the moment iSMA Tool allows connection only with the controllers from “powered by 

Sedona Framework” iSMA family. Working with other devices “powered by Sedona 

Framework” is blocked (more on this in chapter  “Błąd! Nie można odnaleźć źródła odwołania.- 

Błąd! Nie można odnaleźć źródła odwołania.”). 

 

To connect with iSMA-B-AAC20 controller it needs to be added to Workspace Tree: project, 

folder and choose “Add Device” option from the context menu, which results in adding the 

device after entering IP address. First a proper connection to the controller needs to be 

established, which relates to a proper setting of IP address of PC on which iSMA Tool is active. 

The picture below shows a window to add the device to iSMA Tool and a request to enter a 

proper IP address. 

 

The default IP address for iSMA-B-AAC20 controller is: 192.168.1.123.  

“Type” field has only one option to choose - “Sedona”. In the future iSMA Tool will offer an 

ability to connect to other types of devices and the list will be expanded.  

Port: 1876 is a default communication port for iSMA-B-AAC20 controller. If the controller has 

been set to communicate using other port, a proper port needs to be entered.   

After entering the IP address and pressing Enter, or “OK” a login window appears, where the 

required data needs to be entered. 
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WARNING! Saving credentials is dangerous from security standpoint. Please avoid storing 

production system passwords. 

If we want the Username and password needed to connect with the controller to be 

remembered, the “Remember these credentials” option need to be selected. The entered data 

will be saved in (itw) file, which stores the whole structure of Workspace Tree in a way that 

prevents access to sensitive data by third parties.   

After confirming the entered authorization data by Enter or “OK” button, iSMA Tool begins the 

process of connecting and reading the Component tree for the device. The connection 

process along with possible problems is shown in the Console, see the log below: „Connecting 

device ….  connected”. 

 

After a correct connection with a controller, a connected controller’s tree expands 

automatically in Workspace Tree into the “app” application, see picture below. If the controller 

is selected, the Object Properties Window will show its picture and the most important 

parameters, such as IP address, application name, serial number, firmware version number. 

These parameters will be available in this window even after disconnecting the controller, 

which allows offline checking of e.g. device IP number, or its firmware version. 
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5.3. Disconnecting Device 

To disconnect the device after choosing it on the Workspace Tree it is necessary to choose 

“Disconnect” option from the context menu and accept the intent to disconnect. 

 

 

After disconnecting the device its icon’s look will change, it will be impossible to expand its 

contents and the picture will be grayed out, see picture below. Double-clicking the mouse on 

the device again will begin the reconnection process. 
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It is possible that the device will get disconnected by mistake, while working with the 

controller. The system will detect it automatically and inform the User showing a text “Device 

disconnected” in the upper part of the view and folding the device tree on Workspace Tree, see 

picture below. 

 

 

5.4. Device Online Preview 

After connecting with the controller in Workspace Tree, a subtree appears listing all 

Components available in controller, starting with “app” Component - application, through 

“service”, “devices”, or “Logic” (for iSMA-B-AAC20 controller with default application). Every 

change made on Components, such as editing Component name, its parent, or other 

parameters in Component device subtree is saved in controller. This guarantees, after 
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reloading data from controller, the same display of data (Components) and synchronization 

with other Users working at the same time on the same controller. 

Operations, which can be performed on Components, such as: copying, adding, or removing 

new Components, defining connections between Components, etc. are described in the 

further part of instruction. 

Directly after connecting with the device both: Main screen and Device Kits window remain 

unchanged. It is the opening of any Component from the device tree that results in showing a 

specific view in Main screen and filling Device Kits window with proper device Kits. 

 

5.5. Adding a New Component 

To add a new Component in device’s application from Workspace Tree window it is necessary 

to find a specific Component in Device Kits window and drag it to a proper place. The picture 

below shows the process of dragging a single “Counter” Component from the Device Kits 

window, as well as a whole group of Components, which will be placed under “Pumps” 

Component. 
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After dropping a single Component in the specific place in Workspace Tree a dialog window 

appears allowing to name a newly created Component. After name confirmation the 

Component is added to the device and the tree is refreshed.  

 

Many Components can be dragged at once. After dropping them on a Workspace Tree their 

names will be automatically defined, without User’s participation, starting with using a default 

Component name, see picture below. 
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A second method of adding a Component from Workspace Tree is copying and pasting the 

already existing Components or duplicating them. To do it is necessary to select Component 

in Workspace Tree window or Property Sheet, Wire Sheet view and copy it using keyboard 

shortcut Ctrl+C or right mouse menu using “Copy” option. Afterwards it is essential to choose 

Component in Workspace Tree under which the copied Component will be pasted by Ctrl+V 

operation or right mouse menu using “Paste” option.  

The details of copying/pasting operation as well as duplication are described in chapter: “9 - 

One Device Functions”. 



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 26 / 129 

 

5.6. Component Removal 

A Component may be removed from the Workspace Tree window level only after it has been 

selected and the option “Delete” has been chosen from right mouse menu. Removal by 

pressing “Delete” key on the keyboard has been blocked for this window. 

5.7. Link Creation 

In Workspace Tree window the only way of Link creation is using right mouse menu with 

options “Link Mark”, “Link From” described in chapter: “9 - One Device Functions”.  

5.8.  Link Removal 

It is not possible to remove a Link from the Workspace Tree window directly. To remove a Link 

it is necessary to use e.g. Wire Sheet view. 
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6. Device Kits 

Device Kits is a window with a list of Kits available after connecting iSMA Tool to a device. 

This window always shows Kits available in the device connected at the moment. This means 

that if there are many devices used in a project, the window contents will be automatically 

adjusted at the moment of switching from one device to another.  

 

 

Kits are presented as the main elements of tree structure in Kit window, which can be 

expanded to see their Components. Each Component is presented with its icon, name and 

memory it occupies. Icons visible before a Component name define it clearly and help to 

quickly find out what component we are dealing with. An icon connected with a particular 

Component is also shown in other views including Wire Sheet, Property Sheet and the path of 

editable Component. Besides the icons attached permanently to Components, there are two 

special ones, as shown below. 
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The first icon is a default icon for every Component without a defined individual icon. The 

second icon is a warning icon shown for every Component, for which iSMA Tool cannot find a 

defined individual icon. Such situations may occur while adding custom Kits. It requires 

checking if the path for Component icon is correct and if it has been copied to iSMA Tool 

“icons” folder. 

To use a Component it needs to be found and then by “drag and drop” method moved to 

required place, e.g. to Workspace Tree window.  

In order to find a specific Component easily among a vast number of Components available 

for a particular controller, it is possible to use a filter available at the top of the window. For 

this purpose it is necessary to enter the name or part of the name of the required Component 

into the filter field and the matching Component list will be shown in Device Kits window. 

Example below shows a list of Components matched with a word “boolean”. 
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It’s possible to select and the move more than one Component simultaneously by using Ctrl 

or Shift key.  

Using any Kit from the Device Kits window means adding an unconfigured Component with 

default parameters. If we want to add a Component similar to already existing one with pre-

configured parameters to the project, it is necessary to use copying or duplicating function on 

the existing Component.   

The Components dragged to Wire Sheet view (that view is explained in detail in chapter: “10.1 

- Wire Sheet”), are placed in the location they were dropped. If the Components were dropped 

on a view other than Wire Sheet view, their physical location (shown on Wire Sheet view) will 

be upper left corner - point (0,0). 

While dragging many Components to any view, iSMA Tool will arrange them in a cascading 

manner so they will not overlap. 

The Components in a Device Kits window cannot be edited and their location cannot be 

changed.  
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7. Main screen 

The main workspace (Main Screen), where the application is created is the middle, biggest 

window of iSMA Tool. Here the views are shown, such as: Wire Sheet, Property Sheet, or Slot 

Sheet. 

Navigating between many views in Main screen is performed by selecting a proper tab placed 

under the view, see picture below, where a Wire Sheet view for Component “Pumps” is shown. 

 

To show Component data in Main screen it is necessary to: 

● double-click the Component of interest with a left mouse button, which will result in 
showing an appropriate view in the Main screen. A proper view is the one User was using 
last for a specific type of Component. iSMA Tool remembers the preferred view the User 
was using for every kind of Component. For example the type for “Pumps” Component (see 
picture below) is “sys_folder”, so if the User has previously used a Wire Sheet view to see 
other Components of the same type, ex. for “Boiler”, then after double-clicking the “Pumps” 
Component will be opened associated with “sys_folder” in Wire Sheet view.  

● use the mouse context menu on a Component and the “Views” option and choose a 
required view from the menu, see picture below. In this case we have tree views for “Pumps” 
Component, but for other Components there could be more views. In this case three basic 
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views are available: “Wire Sheet”, “Property Sheet”, “Slot Sheet”. After opening any of the 
mentioned views, the opened Component’s type becomes associated with a preferred view 
(see description above). 

 

 
 

After opening a view in Main screen switching between other available views occurs after 

selecting a proper tab in the bottom part of the window. The view change is automatically 

remembered as a view dedicated for a particular Component type. 

Choosing another Component to edit using methods described above will result in replacing 

all views with data of the opened Component. The default view will be the one, which was used 

recently or by default for that type of Component opened.  

There is a concept of workspace environment – a new tab, allowing working on a few 

Components independently, without switching the data in views. To open another, 

independent tab, use key combination – Ctrl + T, or press icon “+”, available on the right side 

of the last tab in the upper part of viewport with a mouse button, see picture below. 

 

 

Tabs raise the work efficiency allowing quick switching between views for different 

Components or even devices. 
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An example below shows that after opening a new tab and choosing Component “Boiler” to 

edit, the tab takes the name of edited Component. 

Now the Main screen shows two spaces corresponding to two different Components: 

„Pumps” and „Boiler”. These spaces can be switched by choosing a proper tab in the upper 

part of workspace, and view contents assigned to these workspaces will be shown 

independently. The picture below shows a Property Sheet view for the second space (second 

tab), while the first space shows Wire Sheet view. 
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8. Object Properties window  

 

Properties Window shows specific information about the selected element: device, 
component, link. It allows a quick preview and editing of selected element data without the 
need for switching, or closing the actual view in iSMA Tool. The object we are interested in can 
be selected in any view and the Object Properties window will show its detailed information. 

The view as well as the contents of Object Properties window may differ depending on the 

selected element. The look of Object Properties window is described below, depending on the 

type of the object selected: 

8.1 Object Properties window - work with a component   
 

Object Properties window view, after selecting a Component, shows 3 sections:  

• section with Slot list,  

• section with a list of outgoing or incoming Links to the selected Component, 

• section with Action buttons, see picture below. 

 

The upper part of View Window shows the icon, name and type of element, whose data it 
displays. (here it is “app [sys::App]”). 

Slot Section – available in “Main” tab, allows reading and editing of selected Component’s 
Slots. If the User changes the value of a Slot in Object Properties window, new value is 
immediately saved in the controller. Object Properties window works in “auto save” mode.  
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This section is also available to Components in Kits (in Device Kits window) and allows to 
check the Slots offered by particular Component even before using it in application. 

Link Section – informs on all incoming and outgoing Links with a full location path of target 

Components and the names of target Slots. For each Link it is possible to choose the following 

options from context menu: 

• “Go to link” – transfer to a Wire Sheet view of the parent of target Component, 

• “Go to component” – transfer to a Property Sheet view of a target Component 

• “Delete Link” – removal of a chosen Link. 

 

 

Action Section – are buttons available above “Main” and “Links” tabs, allowing a simple 
execution of Actions on selected Component. These are the same Actions, which can be found 
using right mouse button, in “Actions” menu. 
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8.1. Object Properties window - work with a device  

After selecting a device Object Properties window look will present useful data about the 

controller, such as IP address of the device (available even after changing of device’s name, 

which results in removal of IP number, being device’s default name), application name, device 

type, firmware version, serial number, etc. Information contained in Object Properties window 

will be available even after disconnecting the device (in offline mode). 

 

 

 

8.2. Object Properties window - work with Links leading to other Wire 

Sheet view 

 

After selecting the “circle” symbol in Wire Sheet view indicating an incoming, as well as 
outgoing link to/from Component, having its beginning/end in some other Component in other 
Wire Sheet view, Object Properties window shows detailed information for Links. The 
presentation method is similar to what was described earlier in “Links” Link section after 
Component selection. More on the link with circle symbol can be found in chapter 14.1.9 – 
Link Between Wire Sheet Views. 
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Object Properties window, as any other window in iSMA Tool, may be freely moved around the 
screen and mounted in other windows, which allows to adjust the window to the User’s 
preferences. It is also possible to place Object Properties window on other connected screen 
if the User is working on multiple computer monitors. 

 

8.3. Properties Window - work with many Components  

iSMA Tool offers the ability to display common properties of many selected Components 

simultaneously.  

Every time the User selects more than one Component, the Properties Window changes its 

header to show the number of simultaneously selected Components, as shown on picture 

below. 

 

Common Slots 

While working with many Components simultaneously the Object Properties window changes 
its work mode to show only the Slots common for the selected Components. The value of 
each Slot will have a specific amount only if all selected Components will have exactly the 
same value for this Slot, otherwise the value field will be empty.  

Regardless of whether the Slot has a specific value, or the field is empty, if it is an editable 
Slot, entering a new value by the User will mean sending it to all Components and overwriting 
various previous values. If this process is not successful, the Console will show an appropriate 
information. 

As is shown on the picture below, selecting 3 Components of different types 
(NVBooleanWritable and NVNumericWritable) resulted in showing only 4 common Slots in 
Object Properties window. ‘Meta’ and ‘Default Trigger’ Slots have an identical value in all 
Components and their value is shown, while the remaining 2 Slots ‘Status’ and ‘History’ have 
different values, therefore there is an empty space in place of value field. 
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Using ‘multi-select’ function for an editable Slot, it is possible to enter a new value, e.g. ‘Cov’ 
for the ‘History’ Slot, which will be sent to all 3 Components, as is shown on the picture below. 

 

 

Setting the same values for various Components simultaneously, described above, allows 
setting common set points, or configurations for many Components at once, e.g. ‘Interval’ 
time for historical ones, ‘Enable’ to activate network variables, etc. 

 

 

Common Actions 
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The situation for common Actions is similar to setting a new value for slots. If the selected 
components have the same Actions then the buttons of these Actions appear in the 
Object Properties Window. Pressing the Action button will send the Action to all selected 
components. 
A good example is an Action of erasing saved historical samples in all historical Components. 
For this purpose all historical Components in Workspace Tree have been selected and Object 
Properties window has shown modified content, as shown on the picture below. 

 

Pressing the ‘clear’ Action button and confirming the action in an additional window will result 
in erasing the history for all variables, which will appear in a proper message in the Console. 

 

 

 

8.4. Properties Window for the Developer Mode   
 

Object Properties window may provide advanced data, such as Component ID, versions of the 
Kit of which the Component comes from and other technical data useful to an advanced user. 
These pieces of information are available in “Info” tab after switching into “Developer Mode” in 
iSMA Tool settings. To switch into “Developer Mode”, File -> Settings needs to be chosen from 
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the upper menu and “Developer Mode” needs to be toggled in settings window. Picture below 
shows Component “app” with advanced information in “Info” tab. 

 

 

Advanced information in “Info” tab are also available after selecting Components in Device 
Kits window, which enables checking who the author of particular Kit is and what its version 
is. 
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9. Console and Logs 

Console is a window where iSMA Tool informs the User about application status and its 

operations. While performing User’s tasks as well as processes, such as object removal, or 

establishing connection with controller, the Console window shows the logs of what is being 

performed at the moment. 

The basic concept in iSMA Tool is that the Console can show all information while only some 

of them are additionally displayed as a pop-up window. 

It’s possible to filter the log contents in the Console by using four buttons: “D, A, I and E”, see 

picture below. 

 

By choosing letters from D to E we consecutively narrow the amount of logs shown in Console 

window. The particular letters meaning is: 

● D - means “Debug” - this mode shows the biggest amount of data in the Console. This 
setting is recommended during programming of controllers for diagnostic purposes, used 
by advanced iSMA Tool users. If this option is not available, it needs to be activated 
manually in iSMA Tool user settings  (see the description further in this chapter) 

● A - means “ALL” - shows all data and this is the basic recommended setting 

● I - means “Important” - shows only the most important data. 

● E - means “Errors” - Console shows only error messages. This is the most restrictive filter 

● Clr - means “Clear” - using this button results in clearing the Console contents 

● Turn the Console on/off - is used to freeze the Console and stops showing new events in 
the Console. 

Despite the chosen filter, very important errors will always be shown on the Console, except 

when the Console is turned off.  

Console window contents, as well as data, which isn’t shown in the Console because one of 

the above filters has been used, are automatically saved in log file to store the information for 

a longer period. Therefore it is possible to open the log file for a later analysis using any text 
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editor. The log files are by default saved in “log” folder. Both, the name of the folder for saving 

logs, as well as its location may be changed by defining a path in User settings (see the 

description further in this chapter).   

iSMA Tool allows to define the size of a single log file, as well as the course of conduct after 

exceeding the maximum log file size. The file size may be from 1 MB to 5 MB (default is 3 MB) 

and there are two courses of conduct after exceeding the maximum log file size: 

● creating a new log file and keeping previous files  

● complete wiping of the actual log file and starting the recording again. 

 

The above settings can be modified in user settings in main menu “File” -> “Settings”. A view, 

displayed when settings menu is opened allows to individually set many parameters of iSMA 

Tool. Among the parameters available, see picture below, are those responsible for log 

configuration and Console window performance. 

 

They are: 

● “Console log level” - filter defining what kind of logs are to be shown in Console window 
(these are the same options as the ones chosen by pressing “D, A, I  and E” buttons on the 
bottom of Console window) 

● “Developer mode” - allows hiding/showing the D - ”Debug” button in Console window 

● “Save console logs” - turns on/off the log recording into a file on hard drive 
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● “Maximum size of console logs file” - defines the maximum size of log file. 

● “Create new log file if max size exceeded” - switch defining how the system acts after 
exceeding the maximum log file size 

● “Path to the log directory” - allows defining of the log file saving location. 

 

iSMA Tool contains a view showing a file, or files with logs saved on hard drive. This view is 

opened by entering “View” -> “Log Viewer” in main menu, see picture below. 
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10. iSMA Tool Settings 

iSMA Tool allows some individual settings for a better fit of iSMA Tool working environment 

to the User’s needs. Such settings include, among others: iSMA Tool interface language, the 

number of remembered, recently opened files of Workspace Tree and Console settings. The 

settings are available at main menu “File” -> “Settings”. 

 

 

 

The meaning of particular settings in “Application Settings” view is clarified by explanations 

placed under the names, see the picture above. Settings regarding the Console and logs are 

discussed in the previous chapter. 

10.1.  iSMA Tool Language Settings 

A default language of iSMA Tool is UK English. 

iSMA Tool allows to change the language in “Application Settings” view. The language change 

regards the graphic interface of iSMA Tool. After the language change the program needs to 

be restarted.   

If your language is not on the supported languages list, feel free to contact Global Control 5 
Technical Support to discuss the options (contact information is available in “About” view, 
opened from the main menu Help -> About). 
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11. Single Device Functions 

iSMA Tool offers many functions such as: Component copying, duplication, removing, linking, 

performing actions, etc. These and other functions discussed in this chapter allow building an 

application in real time - on a connected controller.  

The functionalities described in this chapter are global, i.e. they apply in the following views: 

Property Sheet, Wire Sheet and Workspace Tree window. Individual operation of global 

functions, separately for each standard view, is described in chapter: “14 – Standard Views”.  

An integral way of initiating global functions is using a context menu opened on the 

Components of interest. 

 

11.1. Context Menu 

The Context Menu is displayed after selecting a Component, or Link and pressing the right 

mouse button. 

Context menu content depends on the type of object that has been selected. Menu content 

will be different for one Component, or Link, different after selecting many Components, or 

many Links, and different when Components and Links are selected together at the same time. 

If using one of the options in the menu is impossible for what the User has selected, that 

option will be inactive.  

The options available in the context menu are: 

● Views – allows displaying Component data in one of the defined standard views: (Wire 
Sheet, Property Sheet, Slot Sheet) and other views if they are available for a particular 
Component 

● Actions - performing particular actions for the Components, such as “set” value 

● Copy - shortcut (“Ctrl + C”) - remembering and copying of selected Component along with 
all its properties, settings and Link information 

● Paste - shortcut (“Ctrl + V”) - pasting of previously remembered Components into a specific 
place and possible recreation of internal Links 

● Paste Special - same as “Paste” option plus recreation of incoming external Links, if 
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possible 

● Duplicate - shortcut (“Ctrl + D”) - duplication of selected Components 

● Delete - shortcut (Del) - removal of selected Components 

● Link Mark - defining the Component, from which a Link will be led 

● Link Form - defining of the Component, to which a Link will be led 

● Reorder – changing the order of Components within a parent Component 

● Rename - change of Component name. 

 

The picture below shows the right mouse menu, which will appear after selecting a single 

Component. Options “Paste”, “Paste Special” are inactive because “Copy” option has not been 

used. Similarly “Link From” option is inactive because the source Component for Link has not 

been defined by “Link Mark” option.  

 

 

The right mouse menu visible below will appear after selecting a Link. Apart from removal no 

other operation can be performed on Link. 

 

 

After selecting many Components or mixed objects: Component with Link, most of the options 

are inactive, because iSMA Tool cannot perform operations on many objects simultaneously. 
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Options available in this case will be: “Copy”, “Duplicate” and “Delete”, which will be performed 

on all selected objects, see picture below. 

 

11.2.  Component 

Component is the smallest logical unit having a functionality and requiring entering of specific 

data for it to perform properly.  

Component may be for example an arithmetic function of adding two numbers, therefore it 

requires information about these two elements. These elements may be provided by other 

Components able to read physical analogue inputs of a controller. Thanks to this relation a 

Component will add two analogue inputs. 

A Component on views is presented differently showing various information, as shown on 

pictures below. For a Wire Sheet view (left picture) - Component is shown as a rectangle with 

a limited amount of data, and on Property Sheet view (right picture) it is a table with a big 

amount of data shown in Slot form. Additionally, some of the Slots in the table may be edited 

directly. More about Property Sheet view and Wire Sheet view may be found in chapter: “14 – 

Standard Views”. 
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11.3.  Standardized Work with Components 

Component is the main element of application created in a controller. Therefore iSMA Tool 

guarantees a standardized way of issuing commands to Components. Regardless of whether 

the Component we look at is shown in Wire Sheet view, Property Sheet view, or Workspace 

Tree window, the operations on it are performed in the same way.  

 

11.4.  Component Hierarchy 

Components can be mounted in one another and build a hierarchy that way. Component, 

which has other Components below it is called a parent, and the elements below - children. 

Hierarchy allows to divide a program logically making some Components dependent on the 

others. 

In iSMA Tool hierarchy is presented in Workspace Tree window and on Property Sheet view 

by a tree, whose superior element is a parent, and inferior elements are children.  

Component Hierarchy on Wire Sheet view is limited to one generation. After opening of 

Component (parent) Wire Sheet view shows a schematic with all the Components (children) 

distributed on the view. Picture below shows an open Component (parent) “Boiler” with its 

children on a Property Sheet view on the left and Wire Sheet view on the right. 
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11.5.  Linking 

Link is a way of exchanging data between Components. It defines components between which 

the data will be exchanged. Link specifies precisely which parameter will be taken into account 

on both sides of the connection. This allows showing of data flow direction, i.e. where a 

specific parameter will be read and where it will be saved. 

Wire Sheet view shows link as a line connecting two Components. That topic is further 

discussed in chapter: 14.2.7 – Link Creation). On the other hand, Workspace Tree window and 

Property Sheet view do not show information about existing Links at all.  

Views designed to check connections – Links for a specific Component – are: Wire Sheet view 

and Links view (available in tab in Object Properties window), which will be discussed in the 

further part of the instruction  (14.4 - Links Tab view). 

To create a Link between Components in most cases a universal method “Link Mark” can be 

used, available in context menu opened on a source Component. Next, a right mouse menu 

needs to be opened on a target Component and the option “Link From” has to be chosen. That 

way the User will define a source and target Component to create a connection - Link. Now 

Slots need to be defined in both Components to send and receive data. For this purpose after 

using “Link From” function a dialog window opens allowing User to choose a Slot both on 

source Component side as well as target Component, see picture below. 
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iSMA Tool takes care of connecting “fitting” Slots of the same type, making creation of faulty 

Link impossible. 

11.6.  Adding New Component 

New Component may be created by duplicating an existing Component by using “Copy” or 

“Duplicate” function and dragging a new Component directly from Device Kits window. Each 

of the above methods results in new Component creation along with a new name set with 

User’s help. It is possible to bulk add components of the same type by indicating number of 

Components to add as well as naming pattern in the dialog (see section “11.14 – Bulk name 

patterns” for details). If several Components of different types are added at the same time, 

iSMA Tool will generate unique names to all the Components added automatically.  
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Bulk add dialog allows to add multiple similar Components at once. 

11.7.  Copying and Pasting 

Copying uses standard Windows clipboard and may take place within the limits of one 

controller. Copying always includes all the inferior Components of the selected Component. 

While pasting new Components are created along with their children and Slot settings 

effective at the moment the copying action was performed. The slot value for the new 

Component depends on a slot type: the value is copied for slots of type ‘config’, while others 

are reset to respective defaults. 

In iSMA Tool the object being copied is the Component, copying and pasting of Link alone is 

impossible. Information about all Component Links is stored in the Component itself. That 

means that if a Component is copied and pasted and there is a possibility to recreate its Links 

form a logical point of view, iSMA Tool will do it automatically adding new Links between 

Components. 

Copying in iSMA Tool requires defining Components by selecting them. When “Copy” option 

or Ctrl+C combination is used, a so called “snapshot” is performed on what was selected. This 

allows the “Paste” option to be used in any moment in the future, even after the Components 

the “snapshot” has been used on were deleted, because iSMA Tool automatically recreates 

the copied structure by recreating the needed Components remembered by “snapshot”.  

Copying includes all the Links created between copied Components. This means that while 

pasting, the Links between these Components will be recreated. The situation is different for 
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external Links. Basic function “Paste” does not support the recreation of external Links, this 

needs another function “Paste Special” described in the following point. 

Copied Components may be pasted into a chosen place on the views: Wire Sheet, Property 

Sheet, or Workspace Tree window, by defining the pasting place, i.e. parent and pressing Ctrl 

+ V, or “Paste” from right mouse menu.  

Pasting function can be used many times, because pasting does not delete the memorized 

“snapshot”. The “snapshot” is wiped after device disconnection. The pasting option can be 

performed only within the same device.  

When pasting a single Component the system will ask for a new Component name (with a 

highlighted name suggestion and support for bulk naming patterns, see “11.14 – Bulk name 

patterns”) and number of copies to paste, and for a multi-Component operation iSMA Tool will 

use a mechanism ensuring that the names will be unique. 

Pictures below show operation of “Copy” and “Paste” functions, where newly created 

Components (on right picture, lower part) retained internal Links.  
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11.8.  Special Pasting 

There is an expanded version of “Paste” function called “Paste Special” (available in mouse 

context menu), whose aim is to recreate external Links for copied Components.  

External Links will be recreated only if all the below requirements are met: 

● using “Paste Special”, not “Paste” command from the right mouse menu 

● during “snapshot” definition Components had external input Links 

● external Component, for which an input external Link is recreated still exists.  

 

On the picture below the “Compare” Component has been selected and then the “Copy” option 

has been used, therefore the “snapshot” has been remembered only for “Compare” 

Component, even though it has both input and output external Links. Right picture shows a 

situation after using a “Paste Special” option, where a new Component “Compare1” retained 

the same settings as original and additionally new external Links were created (marked in 

green).  

   

11.9. Duplication 

Duplication is used for a quick replication of selected Component along with its values. The 

slot value for the duplicated Component depends on a slot type: the value is copied for slots 

of type ‘config’, while others are reset to respective defaults. 

 



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 53 / 129 

 

Additionally duplication does not disturb what was copied by using “Copy” and “Paste” 

functions, i.e. it does not overwrite what is contained within “snapshot”.  

Duplication can be performed by key combination Ctrl + D, or from a right mouse menu 

function “Duplicate”, see picture below. 

 

 

   

 

11.10.  Components Removal 

Delete Components allows removal of the selected Components along with all their children. 

Deleted Components are instantly removed from the application in the controller which allows 

full synchronization in views and windows: Property Sheet, Wire Sheet and Workspace Tree. 

Removal is possible after selecting one or more Components and pressing “Delete” key on the 

keyboard, with the exception of removing from Workspace Tree.  

Component removal from Workspace Tree by “Delete” key has been blocked to prevent 

removal of main tree element, such as “app” - Application, or whole “Logic”, by mistake. There 

is still a possibility of removing Components in Workspace Tree by using right mouse button 

context menu, but removal will require confirmation in pop-up window. 

The above limits do not include Property Sheet and Wire Sheet views, where using “Delete” key 

removes selected Components instantly. 
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Link removal is performed automatically after removal of Component, to which a specific Link 

is lead. That includes both: input and output links.  

11.11.  Link Removal 

There is no need to remove Links if we want to remove a Component. However, there are 

situations when only the Link needs to be deleted, without Component removal and that is 

what the described function is for.  

In order to remove only the Link, the Link needs to be selected in Wire Sheet view and then 

deleted by “Delete” key on the keyboard, or from a right mouse menu by choosing “Delete 

Link(s)” option, see picture below. 

 

 

 

11.12.  Actions 

Actions are the most commonly used functions possible to perform on a specific Component, 

such as setting new value, or changing the operating mode of the Component into manual, or 

automatic.  

There are certain operations, which can be performed on Components, called the Actions.  

 

Available Actions depend on the Component type, it is possible to access them from the 

following   
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• After pressing Actions option on right mouse menu button on a Component  

 

• After pressing Actions button available in Object Properties window after selecting the 
required Component.  

 

If the Component does not offer any Action functions then the menu „Actions” is disabled, as 

it is shown on the picture below.  
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If Component action requires entering parameters, as with setting values for Component type 

“NVNumericWriteable”, iSMA Tool will ask for values on a separate pop-up window, see picture 

below.  

 

          

  



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 57 / 129 

 

11.13. Change of Component Order 
While working in iSMA Tool, the order of Components within a parent is automatically set 
based on ID number. The User sees Components set in the order they were added to the 
application and there is no need to change the order to ensure proper work of the controller.  

Building a text interface for LCD display controller is an exception. In this case the order of 
Components allowing to show text information on LCD display is important. It is the basis of 
the look (order) of information shown on LCD display.  

In iSMA Tool it is possible to define the order of Components within a parent the following way. 

• In Workspace Tree or Property Sheet view, Driver view (every view, where the 
Components are shown), select a Component (parent) with children (other 
Components), which will have their order changed. On the picture below the 
Component (parent) is “Local_DI”. 

 

 

• Choose “Reorder” option from the right mouse button menu, which will result in opening 
a pop-up window allowing the order to be changed. On the picture below Component 
“Pump” is being reordered. It is moved with a mouse (drag&drop) to the beginning of 
the list. 
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WARNING! In case of using the reorder function on a childless Component, the same reorder 
function will be used for the parent of the selected Component. This allows using the reorder 
function by selecting one of the Components which will be reordered (provided it has no 
children). 

 

• When the Component order changes are done, they need to be confirmed in pop-up 
window by clicking “OK” button. New order of the Components is instantly sent to the 
controller, which is also illustrated with the order change in Workspace Tree and other 
views showing Components. 

11.14. Bulk name patterns 

Rename pattern defines how the new name for Components will be generated. It could have 

some constant literals with special placeholders embedded. 
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Given the original names of components were "FCU", "FCU1", ... , "FCU12", one can use quite 

complicated pattern to rename them:  

Lvl3_[N-3][C0+2]_ID[C2000-10] 

 

to generate the following names: 

FCU     → Lvl3_FCU0_ID2000 

FCU1   → Lvl3_FCU2_ID1990 

FCU2   → Lvl3_FCU4_ID1980 

… 

FCU8   → Lvl3_FCU16_ID1920 

FCU9   → Lvl3_FCU18_ID1910 

FCU10 → Lvl3_FCU20_ID1900 

FCU11 → Lvl3_FCU22_ID1890 

FCU12 → Lvl3_FCU24_ID1880 
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Placeholder syntax: 

 

"[N]" - Substring of the original name 

"[Nf-t]" - Insert a substring of the original name starting at symbol index 'f' up to the symbol 

index 't'. The leftmost symbol has an index of ‘1’. 

 

Variants: 

"[N]" - the whole name 

"[N5]" - a single symbol at index 5 

"[N3-]" - substring from index 3 to the end of the original name 

"[N3-5]" - symbols from index 3 to 5 

"[N-6]" - symbols from beginning to index 6 

 

"[C]" - Counter 

"[Cf+/-s]" - Insert a counter starting at value 'f' using the step '+/-s'.  

 

Variants: 

"[C]" - counter starting at 1, step +1 (1,2,3,4,5,…) 

"[C5]" - counter starting at 5, step +1 (5,6,7,8,9,…) 

"[C3+5]" - counter strating at 3, step +5 (3,8,13,18,…) 

"[C100-5]" - counter starting at 100, step -5 (100, 95, 90, 85, …) 

12. Kit Manager 
Kit Manager is a manager of a specific device allowing the management of its Kits. The 
manager allows installing and uninstalling of Kits as well as changing a version of Kits already 
existing in a device. 
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Kit Manager allows indication of actions which are to be performed on Kits (adding, removing, 
version change) and performing all actions at once after giving a command to actualize the 
device’s Kits. 

WARNING! Every editing of Kits in a device requires a restart of the device.   

WARNING! Working with Kit Manager for iSMA-B-FCU controller is blocked due to the 
construction and purpose of the controller. 

 

Kit Manager may be opened in two ways - without defining and with defining the device, the 
Kit Manager will cooperate with, already at the start-up stage. 

12.1. Kits Installed in iSMA Tool 
Opening Kit Manager without defining the device it will work with allows to check what Kits 
are currently available (installed) in iSMA Tool, which will be available to be added to the device 
in the next stage.  

To open Kit Manager with a list of Kits available in iSMA Tool it is necessary to choose from 
the upper menu: View -> Device Managers -> Kit Manager. 

 

 

The view, which will appear will consist of two sections: empty upper one for cooperating 
devices and lower one with a Kit list, see picture below. 
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The lower section shows uneditable table, where every row is a Kit installed in iSMA Tool.  The 

meaning of columns is as follows: 

● “On Device” – defines if the Kit is currently installed on a chosen device. In that case, the 
table shows only Kits present in iSMA Tool, so all the checkboxes of this column are empty 

● “Name” – the name of the Kit 

● “Latest Local” – is a number of the newest version of the Kit installed locally in iSMA Tool 

The list of Kits visible in the table corresponds with a physical content of “kits” folder in the 

main iSMA Tool location: „/home/kits”. Proper placing of User’s own Kit in that location allows 

to add it to Kit Manager. 

To update Kits in a device the device which we want to work with has to be exactly defined. 

12.2. Device Kit Manager 

There are a few methods to initiate Kit Manager as well as defining the device it will cooperate 

with. They are: 

1. initiating the Kit Manager from the context menu 
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2. Initiating the Kit Manager from the Object Properties Window 

 

12.2.1. Adding Devices to Kit Manager 

The function of device adding described below may be used regardless of the method Kit 

Manager has been initiated.  

To add a single device, or many devices at once, to the Kit Manager, the required device needs 

to be dragged from the Workspace Tree into the upper part of manager view, where the list of 

chosen devices is. There’s also a possibility of dragging the whole subtree from Workspace 

Tree with many devices at once. In this situation iSMA Tool will filter the dragged objects and 

add only the devices to a view list. The picture below shows a situation after dragging (adding) 

all the devices placed in “Site B – Shopping Centre” subtree. 

 

After adding the devices to manager it is necessary to select one of the devices, which we 

want to currently work with by ticking a checkbox. Only when the device we want to work with 

is defined it will be possible to use Kit Manager for that device. 

Note: Kit Manager allows to work only with one device. The device list in the upper part of Kit 

Manager is used for an easy switching between devices. 

 

12.2.2. Initiating Kit Manager from the Context Menu 

Another method to add a single device to work with Kit Manager is using the context menu 

initiated on the device in Workspace Tree window, see picture below. 
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After automatic opening of Kit Manager the device will be added in the upper area of the view, 

as shown on picture below. 

 

If the device parameters shown in the table (such as the one on the picture above) are not 

specified, before working further with the device it needs to be connected using “Connect” 

button. After a correct authorization and connection with the device all the device parameters 

will be shown as on picture below. 

 

Now it is possible for Kit Manager to work with this device. 

 

12.2.3. Initiating Kit Manager from the Object Properties window 

Another convenient way of initiating Kit Manager for a preselected device is using the button 

available in Object Properties Window. 
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After selecting the device we are interested in the Workspace Tree its data will be shown in 

Object Properties window, as shown on picture above. It is possible that part of the data will 

not be available due to lack of information about the device until the moment of connection 

with this device. Regardless of whether we work connected with the device or off-line, we can 

run Kit Manager by pressing “Kit Manager” button, which will open with a device chosen. 

 

 

12.2.4. Working with Device Kit Manager 

After choosing the device to work with, using methods described earlier, a table is shown with 

a list of Kits, placed in the bottom part of Kit Manager. In the upper part of the table the Kits 

currently installed in the device are grouped, and in the lower part of the table there are filtered 

Kits, fitting to a selected device, which will be available to load into the device. After deselecting 

the device, the filter will be turned off and a whole list of locally available Kits will be shown in 

iSMA Tool, see picture below.  
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The meaning of the columns in the above table is as follows: 

● “On Device” – defines if a particular Kit is already installed on a particular device 

● “Name” - the name of the Kit 

● “Latest Local” – the number of the latest Kit version installed locally in iSMA Tool 

● “Installed” – the number of Kit version currently installed on device 

● “Action” – a list with version numbers of a particular Kit, which are available locally in iSMA 
Tool. By choosing a particular number from a drop-down list we define if there will be an 
“upgrade”, or “downgrade” process of the Kit in device. 

● “Status” – a column, where iSMA Tool informs what will be done with a particular Kit based 
on what the User has required from this Kit. 

User's role is limited to edit two columns: “On Device” and “Action”.  

Below there are descriptions on how to remove, replace and add a Kit to a device.  
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Removing (uninstalling) a Kit from the device. 

If a User deselects the box the selected Kit will be removed. Additionally the information on 

removal of the Kit is confirmed in “Status” column by the word “Uninstall”, see picture below. 

 

It may happen that removal of the Kit is not possible due to connection of that Kit with other 

Kit, or because of the Component being a part of removed Kit which is used in application of 

the device, which is shown by a proper text under the Kit name, see picture below. 

 

In both cases of affiliation before Kit is removed the conflict needs to be solved and then 

removal re-tried. 

 

Replacing the Kit existing in device to a newer, or older one. 

The Kit installed on the device may be replaced by installing newer, or older version of the Kit. 

Both upgrade and downgrade operations are done by choosing a proper number of Kit version 

in “Action” column, please see picture below. 

 

 

Depending on if we replace the current Kit with a newer, or older one, iSMA Tool will inform on 

the planned action in “Status” column by showing: “Upgrade” or “Downgrade”.  
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Adding (installing) the Kit to the device. 

To add a Kit to a device a checkbox by the chosen Kit needs to be selected and, if need be, 

define the version of added Kit, but only if we don’t want to add the newest version of the Kit, 

which is added as default. The intention of adding a Kit to a device is confirmed by a change 

of status in “Status” column into “Install”. 

 

 

Update of Kits in a device 

After defining the Kits we want to add, remove, or change an update command needs to be 

given by pressing the “Update” button on the device, for which the Kit actions were defined. 

That button is in the “Commands” column of a device row, see picture below. 

 

After issuing the command of Kit update in the device a process blocking the iSMA Tool 

interface runs for a period of time, when the Kit update takes place in accordance with User’s 

commands.  

WARNING! The process of Kit update in a device will require restarting the device.  

After restarting the device iSMA Tool will reconnect with the device. 

Note: The update process is monitored in detail in Console window, which helps in analysing 

the situation, where the update could not be completed. 

 

 

12.2.5. Adding External Kits 

iSMA Tool allows to expand the default Kit base with external Kits, e.g. User’s own Kits. To add 

them option “Import Sedona Files”, available in upper menu under “Sedona”, needs to be 

initiated. After initiation a window will open to specify the location of imported files, as shown 

on the picture below. 
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iSMA Tool may import single files or compressed folders with “zip” extension containing: 

● a single kit, 

● whole packages containing kits, manifests and “par” files. 

 

Note: iSMA Tool will accurately read the “zip” package consisting of other “zip” packages 

containing kits, manifests, and “par” files and will display a summary of how many files have 

been imported at the end of the process, in a window and in console, as shown on the picture 

below. If a package contains files, which are not kits, manifests, or “par” files, such files will be 

skipped.  

 

 

After a successful import the added kits are uploaded to Kit Manager. In the lower part of Kit 

Manager view there will be a list of kits, which can be installed on the selected device, including 

the kits, which were added manually. If the external kits do not appear on a list of available 

kits, it means they are not compatible with a selected device and cannot be uploaded into it. 

In that case, after deselecting the device, external kits will be displayed on the list in the lower 

part of the view, because in this mode iSMA Tool shows all kits installed in it.  
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13. Application Manager  

Application Manager is a tool that allows to manage applications of a specific device, as well 

as all the applications saved locally in iSMA Tool. 

Application Manager allows to: 

● manage locally saved applications in iSMA Tool 

● load applications to a specific device 

● download applications from a specific device   

 

WARNING! Loading an application to a device will overwrite the application already present in 

the device. 

WARNING! Each loading of application to a device will require restarting the device.  

 

Application Manager may be initiated in two ways: without defining the device it will work with 
and with defining the device it will work with. 

13.1. Applications Installed in iSMA Tool 
Opening Application Manager without defining the device it will work with allows to check what 
applications are currently saved in iSMA Tool, which will be available to load into the device at 
the next stage.  

To initiate Application Manager with a list of applications available in iSMA Tool one needs to 
choose from the upper menu: View -> Device Managers -> Application Manager. 

 

The view which will appear will be built of two sections: upper, empty of the cooperating 
devices and lower with a list of applications, see picture below. 
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Lower section shows a table where every row is an application saved in iSMA Tool along with 

respective “sax” file. The “sax” file is placed in iSMA Tool structures in folder 

“/home/Applications”. Copying a custom application (“sax” file) to this location allows to add 

it to Application Manager. 

 

The meaning of columns is as follows: 

● “Name” – the name of application and associated “sax” file. The User can edit the name by 
placing mouse pointer on the application name. Giving a new name will automatically 
change the name of “sax” file. 

● “Modification Date” – the date of the last modification of “sax” file 

● “Platform” – name of the type of device, from which the application was downloaded 

● “Commands” – buttons allowing to send the application to a particular device (“Put App” 
button) and “Delete” button removing locally application along with “sax” file from iSMA 
Tool. 

 

WARNING! Using the “Delete” button removes not only an application from Application 

Manager list, but also a physical “sax” file from hard drive. 

 

To download or upload an application from/to the device the device we want to work with 

needs to be specifically defined. 
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13.2. Device Application Manager 

There are a few ways to initiate Application Manager, by: 

• initiating Application Manager from the context menu 

• initiating Application Manager from Object Properties window 

The described rules of manager initiation as well as choosing the device to work with it are 

discussed in detail in the following chapters:  

12.2.1 Adding Devices to Kit Manager 

12.2.2 Initiating Kit Manager from the Context Menu 

12.2.3 Initiating Kit Manager from Properties Window 

 

13.2.1. Working with Device Application Manager 

After defining the device Application Manager has to work with the upper part of Application 

Manager will look similarly to the picture below. In the upper part there is a table of devices, 

where only one device can by chosen at a time by selecting a checkbox.  

 

 

13.2.2.  Downloading Application from a Device (Get App) 

After connecting with a chosen device we can download its application by pressing the “Get 

App” button, see picture below. 
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After issuing the command a process starts, which blocks iSMA Tool interface for a period of 

time, when reading of application from the device occurs and “sax” file creation, whose name 

will derive from application name and device IP number. The newly created file will be added 

to a list of available applications saved in iSMA Tool, and the physical “sax” file will be located 

in iSMA Tool main folder, in location “/home/Applications”. The default name of the application 

file may be changed by editing “Name” column. 

 

Note: Downloading an application from a device does not stop or restart the device. 

Downloading does not disrupt the device’s work.  

Note: Application downloading process is monitored in detail in Console window, which helps 

analysing the situation, where downloading the application couldn’t be completed.  

 

13.2.3. Uploading Application to a Device (Put App) 

Application uploading procedure needs to begin with defining the device to work with 

Application Manager by selecting a checkbox for a particular device in the upper part of 

manager view.  

Next one of the available applications in the lower part of the manager needs to be defined by 

pressing “Put App” button in “Commands” column.  

 

WARNING! Pressing “Put App” button will result in overwriting of the application already 

installed in device and resetting the device in the final phase of the process. 

 

Picture below shows a situation before beginning the uploading of application into the iSMA-

B-AAC20 controller, where the User is asked for confirmation due to overwriting of the 

application currently installed in controller. 
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After overwrite approval confirmation, a process blocking iSMA Tool interface runs for a period 

of time, when iSMA Tool uploads a chosen application and restarts and reconnects the device. 

Note: Application uploading process is monitored in detail in Console window, which helps in 

analysing the situation when application upload wasn’t able to finish.  
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14. Standard Views   

 

iSMA Tool defines few standard views available after choosing the Component. They are: Wire 

Sheet, Property Sheet, Slot Sheet, which are displayed in the iSMA Tool Main Window on 

appropriate tabs. Despite the standard views mentioned above, available for any Component, 

there can also be other, dedicated views for particular Components. 

 

  

14.1. Common Actions in Views 

14.1.1. View History 

While working on application, user switches between views to present objects being worked 

on in a most convenient way. Double clicking on a component in Workspace Tree opens 

corresponding default view. As a convenience matter, iSMA Tool offers a view navigation 

history to allow user to return to previous presentation of objects. 

To achieve that, one could use toolbar buttons or keyboard shortcuts. There are three buttons 

in a toolbar: Previous, Next and History. 

  

Those actions could also be invoked from keyboard using Alt + Left, Alt + Right and Alt + Shift 

+ Left/Right key combinations. 

The history is represented two ways, depending on how it was invoked. Clicking toolbar button 

presents a dropdown list: 

 

While pressing Alt + Shift + Left/Right presents a flyout panel: 
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14.1.2. Undo/Redo 

There is often a need to undo some action: occasionally deleted component, remove 

erroneously added link or return suddenly moved components to their original place. 

With standard key combination of Ctrl+Z and Ctrl+Y iSMA Tool allows to undo/redo actions 

step-by-step. 

Pressing either key combination brings an Undo/Redo History flyout panel to help identify 

what will be undone/redone next. The panel stays in place while user keep holding the Ctrl 

button down so it is nicely visible what will be undone/redone next if multiple changes are 

needed. 
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It is also possible to invoke undo/redo actions or open the flyout panel clicking 

corresponding buttons on a toolbar: 

 

WARNING! As many operations on components involve immediate changes to the device 

over the wire, as well as the device itself could be modified by another user of iSMA Tool 

software remotely, it is possible that some actions will fail to complete. To minimize risks of 

loses to the application user is being creating, undo/redo history is cleared in case of 

unrecoverable communication issues. 

14.1.3. Reconnecting devices 

When one works with multiple devices it is often a case when iSMA Tool has a bunch of open 

tabs, but devices are disconnected. It is possible to reconnect them all at once clicking a single 

button in tool bar. 
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Once action is acknowledged, all devices with at least one tab open would be 

reconnected. To avoid swamping network communication, actual connection commands 

will be sent once User switch to corresponding tab. 

14.2. Wire Sheet  

Wire Sheet is a graphic view, which shows in a graphic form, all the Components along with 

Links for an open Component - their common parent. Each Component in Wire Sheet view is 

shown as a rectangle with a name and icon placed in header and Slot names and values in 

rows underneath. Link is a line connecting two Component Slots, between which an 

information transfer occurs. Picture below shows Wire Sheet view with corresponding list of 

Components in Workspace Tree for “Pumps” Component (parent).  
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In Wire Sheet view the User can define the location of Components by dragging them by the 

header. To make moving Components easier a grid has been introduced allowing precise 

placement of Component. The grid makes organizing of Components and their alignment 

easier.  

 

14.2.1. Component and Link Representation 

Every Component in Wire Sheet view has a following look and behaviour: 

● has a header with an icon and Component name 

● under the header every row represents a single Slot, with a name, value and unit.  

● “Meta” Slot is not displayed. 

● Slots hidden by default are not displayed. 

● A Component may be extended left and right with a width between 5 and 32 grid sections. 
This allows its width to be adjusted optimally, so all the names and their values can be fully 
visible. 

● Component can be moved on Wire Sheet into any place by clicking and holding a left 
mouse button on Component’s header or the middle part of any Slot. Moving the mouse 
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and releasing the mouse button defines new location of the Component, after which Links 
between this and other Components may be renewed. 

● Component moving operation may be cancelled by pressing “Esc” button on the keyboard.  

● Component may also be moved by using “Alt” key and holding left mouse button over any 
part of Component. This allows to grab and drag the Component also behind the place, 
where Link assigning begins. 

● Selected, i.e. clicked with a mouse, Component is marked with an orange frame and will be 
treated by iSMA Tool as an object chosen by User. 

● The marked Component is surrounded by a green frame and will be treated by iSMA Tool 
as a reference (auxiliary) object, not selected.  

● A context menu available under right mouse button provides functions, which can be 
performed on a Component regardless of the view it is shown in.  

Every Link in Wire Sheet view has a following look and behaviour: 

● Links between Components reflect the connections between specific Slots of connected 
Components. 

● A Link guarantees sending the value of source Component Slot to a target Component 
Slot. 

● A single Link cannot branch out and is always unidirectional from the output of the source 
Component Slot to the input of target Component Slot. 

● Only one output Link can be defined for an input (left) Slot. 

● There can be many output Links coming out of one output (right) Slot  

● Links connecting Components from different Wire Sheet are graphically represented as 
short segments coming in/out of Slots ended with a full circle. 

● A context menu available under right mouse button allows to remove a selected Link. 

● The User has no influence on a Link route, i.e. the way it will be drawn, since the process is 
done automatically. 
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14.2.2. Navigation 

Navigation on Wire Sheet view is done by zooming in/out and moving the contents of the view.  

To zoom in - enlarge the contents of the view - a mouse wheel needs to be turned. It is worth 

noting that during zooming in a point, where the mouse pointer is, does not change its location. 

So, if we are interested in a particular Wire Sheet view fragment, before zooming in we need 

to move the mouse pointer into this area, so it does not “escape” our field of view.  

Moving the contents of a window - scrolling, is done by moving the sliders at the bottom and 

right side of the window, or by pressing and holding the left mouse button with “Ctrl” button 

pressed at the same time. 

After opening the Wire Sheet view iSMA Tool automatically chooses the zoom allowing all 

Components to be visible. 

Pressing “F” key on the keyboard at the keyboard at any time will automatically rescale and 

move the view, so all the Components can be visible. 

14.2.3. Selecting and Marking Components/Links 

Wire Sheet view has been designed to make it easy for the User to analyse the logic of the 

program by proper marking of the inferior Components and Links in relation to a selected 

Component or Link, see picture below. 
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On the picture a “LeadLag” Component has been selected - orange frame. If it will be removed, 

or moved, or duplicated, it will influence the Links connected to it and their Components. For 

this purpose the connected objects have been highlighted in green. A colouring mechanism 

shown above may be very useful to analyse complex programs with many connections - Links 

or Components.  

A similar occurrence of colour highlighting takes place if a Link is highlighted - colour orange. 

In that case iSMA Tool will automatically mark - with a green colour - all the Components 

connected with that Link. This allows the User to be aware what Components is the Link 

connected to and what should be done in case it is for example deleted, see picture below. 

 

 

14.2.4. Selecting by a Region  

In the Wire Sheet view, apart from selective choice of the elements by selecting them using 

“Ctrl” key, there is another, more advanced method of selecting Components and Links.  That 

method involves defining a rectangular region of object selection in two types: “window 

selection” and “cross selection”. 

Both types require creating a rectangular shape in Wire Sheet view by pressing (in an empty 

space) and holding a left mouse button. Creation of the second corner of the rectangle as well 

as completion of the drawing process occurs when the left mouse button is released. 
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In case of “window selection” (see pictures below), a rectangle drawn from left to right will be 

blue. In result only the fully included objects are selected (orange colour), here “LeadLag” 

Component and its two Links. The remaining elements were not selected because they were 

not fully included in the blue rectangle. The elements dependent on the selected “LeadLag” 

Component and selected Links are marked in green. 
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In case of “cross selection” (see pictures below) the rectangle is drawn in the opposite way, 

from right to left and it is red. In result all the objects, even partially included in selection 

rectangle, will be selected (orange colour), here it’s “LeadLag” Component along with all its 

Links and Components: „FloatTo” i „FloatT1” with output Links.  
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“Cross selection” method, described above, enables easy removal of all the Links entering a 

specific Component without the need to individually select every Link.  For this purpose a long, 

narrow rectangle needs to be drawn across the Component, crossing the Links, see picture 

below. In result all the Links will be selected (orange colour) and it will be possible to delete 

them using “Delete” button or right mouse menu. 
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14.2.5. Adding a Component 

To add a new Component to Wire Sheet view a new Component needs to be dragged or pasted 

from Device Kits window, or already existing Component needs to be duplicated.  The 

Component being added in Wire Sheet view will be placed in accordance with the following 

rules: 

● if it is being dragged from Device Kits window, the mouse position at the time of releasing 
the left mouse button will decide its position in Wire Sheet view 

● if the pasting is being done using “Paste” or “Paste Special” option initiated by right mouse 
context menu, the pasted Component will be placed at the mouse pointer position in Wire 
Sheet view at the time of initiation of pasting function 

● however, if a Component has been added to a view other than Wire Sheet, ex. to Workspace 
Tree, its position will be the same as original Component (including cascade offset) in case 
of pasting, or duplicating, and for dragging a Component from Device Kits window into a 
view other than Wire Sheet, the position will be (0, 0), e.g. It will appear in the upper lower 
corner.  

In all cases the added Components are slightly relocated relative to the original Components, 

so they will not overlap. iSMA Tool uses so called cascade here. 

 

14.2.6. Component Removal 

A Component in Wire Sheet view can be removed after selecting it and pressing the “Delete” 

button on the keyboard, or choosing the “Delete” option from right mouse menu. After 

removing a Component iSMA Tool will automatically remove all Links connected to the 

removed Component. If necessary, the remaining Links will be redrawn to use the space 

remaining after the removed Component.    

 

14.2.7. Link Creation 

According to what was described in chapter “11.5 - Linking”, Link is a way of data exchange 

between Components. Link defines which Components will exchange data, precisely defines 

which parameter on both sides of the connection will be taken into account and defines the 
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direction of data exchange, i.e. where the parameter will be read, and where it will be saved. 

For a Wire Sheet view a Link is a broken line connecting Slots, whose data is being exchanged.  

A Component has many Slots. They can be input Slots, able to receive new data sent by a Link 

and output Slots, being an effect of calculations performed inside a Component, which can be 

sent further by a Link. For the data exchange between Slots through the Link to be possible, a 

type of data sent and received must be the same. That match translates to a Link creation 

process, which can start at any Slot, but the Link connection finishing Slot must “fit” - be of the 

same type as source Link. iSMA Tool watches over that compatibility making Link connection 

ending impossible.   

 

Link on Wire Sheet can be added by defining beginning Component and end Component of 

the created Link using “Link Mark” and “Link From” options (described in detail in chapter: “11 

- Single Device Functions”. 

For a Wire Sheet view there is another way of creating Links, a graphic way. 

To use it, a Link drawing must be started by pressing and holding the left mouse button over 

the required Component Slot. From that moment further movement of mouse pointer draws 

a Link, whose beginning has been defined in previous step. Next, a Slot of the other end of 

created Link needs to be defined. iSMA Tool makes that process easier suggesting by 

colouring in orange the “fitting” Slots, where Link creation can be finished. The intensity of Slot 

colouring depends on the distance of the mouse pointer, see picture below. 
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On the picture above, the Link has been started in “Out G” Slot of “Sequenc” Component and 

finished in Slot of Component “Or2”, iSMA Tool suggests that the “fitting” Slots close to mouse 

pointer are „In C”, „In D”. In the last phase of Link creation, after hovering the mouse pointer 

over “fitting” orange Slot, the green “hooks” will be helpful, which will pull the mouse pointer to 

the chosen Slot. Then the Slot choice needs to be accepted by releasing left mouse button, 

see picture below. 

 

The result of Link defined this way will be drawing of a connection created between specified 

Slots.  

The Link drawing process shown above can be started in the opposite way, i.e. first defining 

Slot “In C” of Component “Or2” and drawing it in the direction of “Sequenc” Component. The 

end effect would be identical, see picture below. 
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The newly created link is selected, therefore it can be instantly deleted using “Delete” button. 

In Wire Sheet view not always all Slots of a particular Component are visible. There are so 

called hidden Slots, which by default aren’t shown in rectangle representing the Component. 

A hidden Slot will be shown and placed among others visible Component Slots after a Link is 

led to it. A Link to hidden Slot may be defined using special linking window discussed in 

chapter ”11.5 - Linking”, whose initiation may occur in two cases: 

● using “Link Mark” and “Link From” function from a right mouse menu on a Component 

● while drawing a Link, by defining source Slot and/or target Slot on empty, last 

 Component Slot (see picture below). 

 

The second case - “empty” Slot method has a particular usage, if in Wire Sheet view we want 

to create a Link to a hidden Slot. A picture below shows a process of Link drawing using an 

undefined Slot in target Component, which becomes defined in the next step, i.e. with a dialog 

window. 

 

Dialog window opens with one Slot already defined, the one which User has chosen at the 

beginning of Link creation -”Out G”, see picture below.  
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A choice must be made of a fitting Slot in Component “Or2”, right column and it has to be 

confirmed by pressing “OK” button. 

It need to be added that due to finishing of Link defining, with any method, the information 

about a created connection is directly saved in controller. 

14.2.8. Link Removal 

Link in a Wire Sheet view can be removed after selecting it and pressing “Delete” key on the 

keyboard, or choosing option “Delete Link(s)” from the right mouse menu. After Link removal, 

if need be, the other Links will be redrawn to use the space left after removed Link.    

 

14.2.9. Link Between Wire Sheet Views 

In practice, it happens sometimes that there needs to be a logical connection between 

Components belonging to different parents, i.e. Coming from different Wire Sheet views. For 

this purpose, in Wire Sheet view, input and output Links of the Component are intermittent and 

finished with a full circle.  This sign means that the further part of Link is continued in another 

Wire Sheet view, see picture below.  
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Additionally for Links going out to other Wire Sheet there can be a number by the circle sign 

informing of the quantity of Links led from a particular Slot. On the picture above from the 

Component “Pump1 Out”, Slot “Out” there are three Links going out to other Wire Sheet. 

Information on the Slot and Component to which the outgoing Links are transferred can be 

obtained in Object Properties window after selecting “circles” Link, see picture below. 

 

 

Object Properties window (on the right) informs of three Links with a full location path of target 

Components and Slot names. 

In Object Properties window for each Link it is possible to choose the following options from 

context menu: 

● “Go to link” – transfer to a Wire Sheet view of the parent of target Component 

● “Go to component” – transfer to a Property Sheet view of a target Component. 

● “Delete Link” – removal of a chosen Link 
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14.3. Property Sheet  

Property Sheet is a tabular view listing all of the selected Component’s Slots as well as Slots 

of its children. Slots shown in table rows provide information about Slot’s name, its current 

value, unit and range, see picture below.  

Property Sheet view allows selection of only one Component, on which typical functions of 

one device can be performed, including copying, duplicating and removal. 

Each Component in Property Sheet view is shown as a tree, where leaves are the Slots. Slots, 

which values can be edited are highlighted with a different background. 
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The system allows, by double-clicking on a Slot value, to change it if that Slot is of Read/Write 

type. Slot, which value was in editing mode is highlighted by changing the colour of the value 

font to blue, see picture below. 
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A change of Slot value and saving it in a controller may happen directly after introducing new 

value and confirming it with “Enter” key, or when the User decides to do it by sending new 

values to controller using “Save” button. These are the two ways of saving edited values of 

Slots that Property Sheet view offers: automatic and manual, see picture below. 

   

The change of saving method is done by a binary key, located in the upper left corner of 

Property Sheet view, where “off” (see picture) means turning automatic mode off. Turning off 

the automatic save mode results in displaying in lower right corner of Property Sheet view 

buttons “Save” and “Cancel”, enabling “manual” saving of changed values of controller Slots. 

iSMA Tool will remind the User of unsaved values in “manual” mode when trying to close 

Property Sheet view and before disconnecting with a device, or closing the program, see 

picture below. 

 

 

14.3.1. Adding a Component 

A Component can be dragged from Device Kits window to Property Sheet view to create a new 

Component. The dragged Component will always be added as a child of a selected 

Component. If the dragged Component is dropped in an unoccupied field under the tree in 

Property Sheet view it will be added to the main Component of that view. 

14.3.2. Component Removal 

After selecting the Component in Property Sheet view it can be deleted with a “Delete” key on 

the keyboard, or by right mouse menu. 

14.3.3. Link Creation 

The only way of creating a Link in Property Sheet view is using right mouse menu with options 

“Link Mark”, “Link From” discussed in chapter: 11.5. Linking. 
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There is no possibility of Link removal in Property Sheet view. To remove a Link you should 

use for example a Wire Sheet view. 

14.4. Links Tab view 

 

Links Tab view is a view showing the list of all Links incoming and outgoing of the selected 

Component in Object Properties view. From the table of that view a full path can be read, 

including the name of the Slot where the second of the Link is connected.  

This view is a dynamic one and it is updated constantly by downloading data directly from the 

controller. 

The picture below shows a selected Component in Wire Sheet view. Object Properties window 

has instantly shown all its links in “Links” tab. 

  

 

Choosing one of the links in “Links” tab you can: 

• go to the parent of its other end (Wire Sheet view) – “Go to link” option 

• go to a second Component (Property Sheet view) – “Go to component” option 

• delete the selected link – “Delete Link(s)” option 

 



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 96 / 129 

 

 

 

  

14.5. Slot Sheet 

Slot Sheet view is a list of Slots of a given Component. This is not a dynamic view. This means 

that the status of Component Slots is read once, during the opening of the view.  

This view informs of the Slots of an opened Component. They are: Slot type, Slot variable type 

and Slot “Facet” interface.  

The Slot list contains all Component Slots, including hidden Slots, which are not visible in Wire 

Sheet view. For a “LeadLag” Component shown above it is a number of Slots much higher than 

presented on a picture of Wire Sheet view, see picture below. 
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15 Historical Data 

iSMA Tool allows to perform an analysis of historical trends by using two views: „History Chart” 

and „History Table”. The first view allows to work with a single trend, as well as many trends 

on a graph versus time. The second view is a table of registered samples of one of the 

processes. 

Accessing both views is possible from the Workspace Tree at app -> service -> history -> db1. 

Under “db1” Component, which is a historical database, there are historical variables 

registered in iSMA Tool shown by Components, see picture below. 

 

Opening any Component under the “db1” Component will open the selected Component in a 

Main screen along with all its views in tabs, including both views discussed above. On the 

picture below a view after opening the “random” Component is shown. 
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The second method of working with historical data is opening the “db1” Component, i.e. 

historical database and dragging the Component we are interested in from the Workspace  

Tree to an empty “History Chart” view.  A picture below shows an empty “History Chart” view 

of “db1” Component awaiting the definition of historical data to be drawn. 

 

 

15.1 History Chart View 

History Chart view is a view dedicated to a graphic presentation of historical data versus time, 

commonly called a graph. A graph is a line connecting subsequent samples, defined in a time 

interval and a range of values. The graph is located in the upper and main area of the view. 

Below there is a smaller area with a preview of the whole available range saved in controller. 
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In preview area there is a possibility of setting with a mouse a left and right time limits against 

which the trend will be drawn in the main area above. 

 

After setting the time limits mentioned above, the corresponding graph has been significantly 

narrowed and looks as shown on the picture below. 

 

 

To analyse the value of a historical graph a mouse pointer will be used, moving over the 

registered samples and showing their precise values, and additionally, using auxiliary lines, 

shows values on vertical and horizontal axis of the graph. 

Pressing and holding the left mouse button allows to move the graph and using the mouse 

wheel an interesting graph fragment can be zoomed in/out. Each change of graph range is 

updated in preview area under the graph. 

It is possible to add another trend to the observed chart and display them both simultaneously 

for analysis. To add another trend, a trend we are interested in needs to be dragged from 

Workspace Tree, from under the “db1” tree to the opened chart. A picture below shows a 

situation after adding “RampCounter” trend. 
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After adding another process, the upper graph and preview area has been updated 

accordingly. Because two processes are displayed, the mouse pointer along with auxiliary 

lines tracks and shows registered samples independently for two processes.  

By default, after adding a second trend the value scale is common for both processes, but 

individual scales can be displayed for each of historical processes. This is allowed by 

“Enable/Disable Secondary Axes” option in context menu displayed after pressing the right 

mouse button on any part of the graph. 

 

After initiating an individual “oy” axis, for each of the processes, trends are automatically 

rescaled to cover as big part of the graph area as possible, see picture below. 

 

When working with many processes a function of temporary hiding of one of historical lines 

will be useful. It is done by deselecting a line in the key. The key is placed in the upper right 

corner of the graph. 
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The remaining options of context menu allow returning to the default values of zoom and shift, 

“Reset Zoom” function and export/printing of “Export/Print” function. 

Initiating “Export/Print” starts a “Preview” application allowing to print and export the visible 

graph. Among the offered export formats there are: pdf, html, docx, xlsx, bmp, gif, jpeg, png, 

tiff, emf, wmf. A detailed description of the function is available in chapter: 0 - 16 Exporting 

and Printing Program - Preview. 

 

15.2 History Table View 

History Table view shows, in tabular form, all the saved samples for one historical Component. 

As in case of “History Chart” view, discussed above, the table can be printed or exported using 

“Preview” program. “Preview” program is initiated from the context menu in this view and its 

description can be found in the further part of documentation. 
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16 Exporting and Printing Program - Preview 

After running the “Preview” program the screen will look similar to the picture shown below, 

and printing/export of graph/table will require defining few of the parameters described below. 

 

 

To adjust the graph we will need functions provided in Preview program toolbar. 

In most cases the page orientation needs to be changed to horizontal by using “Orientation” 

button. 

 

Next, the margins can be made narrower by using “Margins” button and choosing “Narrow” 

type and set a proper page size, e.g. A4 using the “Size”-> “A4” button. 

If after the above adjustments the print does not fit to one sheet of paper, and we would like 

to export or print it only on one sheet, the scaling needs to be changed using the “Scale” button 

and setting “Fit to 1 page wide”.  

As a result of above adjustments our graph will look as on the picture below and it will be ready 

to be printed, or exported. 
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To begin printing the “Print” button needs to be pressed. It allows to choose the printer and its 
parameters. It is possible to print immediately using default printer without the intermediate 
printing window. It is done by pressing the second button - “Quick Print”. 

                                                                     

 

 

The exporting can be done in many formats and, depending on the format chosen, additional 
parameters can be set. Among the offered export formats there are: pdf, html, docx, xlsx, bmp, 
gif, jpeg, png, tiff, emf, wmf. The button responsible for exporting is “Export to”. Another form 
of exporting is the option, offered by the second button, of placing the exported document 
directly into email message to send it as attachment. 
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17 Schedules 

For the purpose of schedule setting a dedicated Schedule Weekly view has been created in 

iSMA Tool. Schedule Weekly view allows setting a schedule easily, which is described further 

in the document.  

While working with a schedule the Object Properties window is very helpful, because after 

selecting a schedule type of Component that window offers few significant Slots. Picture 

below shows a situation after selecting a Component of schedule type. 

 

Current output value of a shown schedule is 22.00, which is indicated by the “Out” Slot on the 

Component and “Current Output” Slot in Object Properties window. The remaining information 

in Object Properties window is as follows: “CurrentTime” and editable value “Default Value”. 

The current controller time, based on which the schedule works, is defined by “CurrentTime” 

Slot. “Default Value” is a default value assumed by the schedule for undefined time intervals 

(details are described further in documentation). 

To open schedule settings a Component edit needs to be opened by double-clicking it with a 

mouse. A default view for schedule type Components is “Schedule Weekly” view, such as 

shown on the picture below. 
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In this view a one week calendar is shown, divided into days and hours. Enlarging the calendar 

by turning the scroll wheel will result in a more detailed time division within 5 minutes, instead 

of 1 hour.  

Time intervals and corresponding values of output Slot need to be set for a schedule in this 

view. In other places, where there is no precise value set, the “Default Value” value takes effect.  

As shown on the picture below, the schedule needs to be read as follows. From Monday till 

Friday the process is as follows: until 8:00 AM there is no specific setting - schedule takes the 

default value 20.00. Later, until 5:00 PM the setting is 22. After that, until 7:00 PM, the setting 

is 21, and after 7:00 PM the default setting applies again. At the weekend the setting is 19 for 

the whole time. 

Editing of schedule involves selecting the required time interval with a left mouse button. After 

selecting the interval a context menu needs to be opened, providing the following options, as 

shown on picture below: 
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● “Add Event” - allows creating a new event, namely schedule settings in the defined time 
interval accordant to what was earlier selected with a mouse. After choosing that option 
the following window appears. 

 

 

 

 

 

 

 

 

 

In the “Value” field a required value for that time interval needs to be entered, e.g. 18.  

The “Day Of Week” field, shown below allows, if need be, to change a day of the week relative 

to the day which was selected with a mouse in calendar.  

The following two fields are the beginning and end of the created event, which by default have 

the time set in accordance with the one chosen with a mouse, but can be edited here.  

The event is created after confirmation with the “OK” button, shown on picture below. Now, on 

Monday, from 01:00 AM till 05:00 AM the setting will be 18, and after that it will be in 

accordance with what was described earlier. 
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● “Copy Day” - an option in context menu allowing to copy all the events for particular day to 
paste them later 

● “Paste Day” - option allowing to overwrite the selected day with the events copied from 
another day (“Copy Day”). 

● “Paste Day To Monday-Friday” – this option can be initiated for every day in the schedule 
and results in copying and overwriting of all the events of selected day to all days from 
Monday till Friday. 

● “Paste Day To All Week” – similar to “Paste Day To Monday-Friday” option, but in this 
instance all days of the week will be overwritten (whole week). 

● “Clear Day” – choosing this option on a particular day results in removal of all the events 
that day. 

● “Clear All” – choosing this option on any day of the week results in removal of all the events 
in whole schedule (whole week). 

Editing of an already existing event may be done by dragging the whole event within 

particular day or by changing the beginning and end hours using a mouse by extending or 

narrowing the border of the upper or lower event. Full editing, including opening of the 

same window as while creating new event, may be accessed by double-clicking the event 

with a mouse, or by choosing “Edit Event” from the context menu. 

The selected event may be removed using “Delete” button on the keyboard, or by choosing 

“Delete Event” from the context menu. 

Remember: All the changes in a schedule described above are sent directly to a controller 

and will be immediately taken into account in application’s logic. It means that removing 

any event may result in a change of application’s behaviour in controller due to the change 

of schedule output parameter value.  
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18 User Manager 

 

iSMA Tool allows managing of users in a controller using a dedicated User Manager view. It 
allows defining of the range of changes in controller application for every User. The initiation 
of a list of already defined users in “User Manager” view is done by opening “users” Component 
available at “app” -> “service”, see picture below. 

 

User Manager view shows the defined Users, allows to edit their permissions and passwords 
and makes it possible to add a new User and remove an already existing one. 

The picture above shows two Users defined in controller: “admin” and “lcd”, with different 
access permissions defined in the following table columns. “admin” User has no restrictions 
(empty columns) and has full access to everything, while “lcd” User has defined restrictions in 
accordance with rules set by Sedona environment and represented by columns:  

● “Group1”…“Group4”  - group 1...4 shows permissions given to Components assigned to 
these groups  

● “Provisioning Permissions”  - defines what services a particular User will be able to use 

● “Commands” column has a button allowing to set a new password for a User 

Editing of every table field described above is done by clicking a particular column with a 

mouse, as shown on pictures below. 
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Adding a new User to a controller is done by using “Add User” button placed in the lower part 
of User Manager view. A user name has to be entered into “Username” field and a password 
into “Password” and “Repeat Password” fields, as shown on picture below. After adding a new 
User iSMA Tool will automatically create a Component with the same name as user name and 
will expand the user list in User Manager view. 

 

Note: It is not recommended to change the user name (Component name) after setting a 
password. If it is necessary to change a user name, a new password should be set after that.  

Note: In case a Component representing a User is duplicated to create a new User with the 
same permissions, new User should also have a new password set.   

Removing of a particular User may be done using two methods: either by removing the row in 
User Manager view after selecting it and pressing “Remove User” button, or by removing the 
Component representing that User. 

  



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 111 / 129 

 

19 Date Time Service 
 

iSMA Tool allows precise setting of the time in the connected controller including the time 
zone and a potential change of time connected with daylight saving. For this purpose a special 
‘DateTimeService’ view has been created, accessible by double-clicking the ‘time’ Component 
available at app -> service -> time. Picture below shows ‘DateTimeService’ view displaying 
current controller time in section ‘Current’ in the left upper part of the view.  

In case shown below, it is a time typical for a part of the USA and Canada (UTC – 07:00 
Mountain Time US & Canada). 

 

 

Setting the time and time zone 

The ‘Desired’ panel shown below sets the time and time zone, which will be sent to a controller 

after pressing the ‘Save’ button in the lower right corner of the view.  

To set a chosen time in the controller, the time and time zone need to be set up using one of 

three methods: 

• manually enter the time and time zone expanding ‘Time’ and ‘Time zone’ fields, 

• read the current time and time zone of the controller by pressing the ‘Use Current 
Settings’ button, and then edit it, 

• read the current time and time zone of the computer operating system in which 
iSMA Tool is running by pressing ‘Use Local Time’ button, and then edit it. 
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Using one of the three ways described above allows setting the time and time zone ready to 

be sent to a controller, it is indicated by a blue color of settings, see picture below. 

Using one of the three ways described above allows setting the time and time zone ready to 

be sent to a controller, it is indicated by a blue color of settings, see picture below. 

   

After pressing the ‘Save’ button, the settings sent to a controller return to their initial colors. 

WARNING! System will not allow setting a time before year 2000. 

 

Defining daylight saving time 

‘Daylight Saving Time’ (DST) panel on the right side of ‘DateTimeService’ view is used for 
setting the daylight saving time that is an automatic time change on a specific day of the year.   

WARNING! If changing the time in connection with daylight saving is not required (e.g. the 
country the controller is working in doesn’t use daylight saving) ‘0’ should be put into ‘Offset’ 
field, as is shown in the picture below. 

 

 

After entering the settings for beginning and end of daylight saving time, the changed 
parameters, which will be sent to the controller after pressing ‘Save’ button, are indicated with 
blue color. After successful sending of the data to the controller, to color will return to default 
one. 
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WARNING! If, while leaving the ‘DateTimeService’ view, the system shows a prompt saying 

that not all of the data on current view has been saved, you should accept it and save the data. 

 

WARNING! Sending the settings to a controller is not tantamount to permanent saving of all 

settings related to time in the controller. After sending the data with a ‘Save’ button, it is 

necessary to additionally save it in a non-volatile ‘flash’ memory of the controller by clicking 

the floppy disk icon on a toolbar in the upper part of the screen. 
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20 Alarm Service 
iSMA Tool provides a summary table of all the alarms registered in a controller. This table is 
presented in ‘Alarm Table’ view available at app -> service -> alarm -> alarmDb. 

 

Opening the view results in downloading a file with alarms from the controller and displaying 

its contents in the table, as shown on the picture above. The meaning of columns is as 

follows:  

• Source Name – name of the Component, which generated the alarm 

• Source Path – path to the Component 

• Update Timestamp – time of the last update 

• Normal Timestamp – time of switching to normal state 

• Offnormal Timestamp – time of switching to alarm state 

• Offnormal Value – alarm value 

• Alarm Class – alarm class 

• Alarm State – alarm status 

• Alarm Message – alarm message 

WARNING! Alarm view is a non-editable view and its contents are read from the alarm file 

only while the view is loading. 
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21 Custom Table View 

iSMA Tool allows every User to define in a simple way tabular views for any Components 

through proper defining of xml files.  

Tabular view is another view, which will be available beside main views of each Component, 

such as Wire Sheet, Property Sheet and Slot Sheet.  

This view filters subordinate Components (children) making work with complex applications 

composed of many Components (children) of different types much easier. 

Imagine a situation when under a folder-type Component (parent) we place many different 

Components, including NV Components. Now, if we would like to find all NV Components, we 

would need to identify them among many other Components and view their values in Object 

Properties window. By defining one xml file properly we are able to create an additional tabular 

view for every type of Component in iSMA Tool, which will list only particular types of 

Components. For the example mentioned above it would be a view filtering all NV 

Components. 

Global Control 5 wants the User to be able to create tabular summaries of Components 

according to his needs, without the need to delegate it to GC5 company. 

Each view created that way will require following characteristics to be defined: 

• Tabular view name 

• Types of Components for which the tabular view will be displayed.  

• Types of Components, which will be displayed in tabular view along with their 
common Slots    

The picture below shows an example of a tabular view filtering NV Components. While working 

with a view defined this way (here named ‘NVValuesManager’) iSMA Tool limits the number of 

Components available in Device Kits window, making it easier to add proper Components to 

the view. After switching to other view (choosing a tab for other views) Device Kits window 

will return to normal working mode displaying all Components available in the device. 
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iSMA Tool provides properly configured tabular views for all the devices from iSMA family, 

which are described in detail in the next chapter. 

  



iSMA Tool 

Version 1.2.2 www.gc5.pl  Page 117 / 129 

 

22 Work with predefined Drivers views   

22.1 Tabular drivers views hierarchy  

iSMA Tool has specially designed tabular drivers views to make the work of adding and 

maintaining the devices working in the network and exchanging data among them as easy as 

possible. Predefined drivers views will be discussed based on an exemplary complex 

configuration of many networks and devices.  

Tabular drivers views may be divided into 3 hierarchical segments:  

• First segment is a table with the view of all drivers, that is networks. It is called “Driver 
Manager”. For the example shown below, the table shows the status of, among others, 
the following networks: ‘localIO’, ‘ModbusAsync’, ‘OneWire’, ‘ModbusTCP’, ‘BACnet’. 

 

• Second segment shows the devices for the network selected from the first segment. 
For the example shown below, the devices are ‘MIX18’ and ‘Mini4I4O’ for the network 
(driver) – ‘ModbusTCP’. The name of that view depends on the type of the chosen 
network, here it is ‘Modbus TCP Device Manager’ view. 

 

• Third segment is a list of network points, that is variables allowing to read/record 
particular data from a particular device. For the example shown below, the digital 
points are ‘RoomLight1..4’, their read is available through device ‘Mini4I4O’. The name 
of the views showing network points depends on the name of the device the data 
comes from, e.g. ‘Modbus TCP Point Manager’ view. 
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Generally, the 3 drivers views’ segments described above may graphically be presented as 

follows: 

 

 

As it is shown on the above diagram, network points may be grouped in network folders 

(Points Folder) and nested any number of times, which allows grouping and ordering large 

quantities of network points under a particular device (here ‘Schedule’ and ‘Setpoints’ are 

folders grouping points History1,2 and Setpoint1,2,3 respectively). 

You can see on the diagram above that the views construction of particular segments is very 

similar, so one type of table for each of the segments may display all the necessary data.  

It will be described in detail further on how networks should be built based on devices 

distributed among Kits and points available in iSMA Tool.  

Then we will concentrate on how the XML configuration files are built and we will show how 

the inbuilt tabular views for drivers views were defined. That knowledge may be used to build 

custom tabular views to expand drivers views with custom networks, devices, points or to 

create completely new views for other application zones. 
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22.2 Work with tabular drivers views 

 

This chapter shows how to add a network, devices and points, using inbuilt tabular views, in 

accordance with what was described in the previous chapter, divided into segments. 

 

Segment 1 

 

To add a new network (driver) to application you need to open a proper ‘Driver Manager’ view, 

available at app -> Drivers, chosen from the Workspace Tree. After opening the ‘Driver 

Manager’ view the required driver (Component) representing the proper network needs to be 

dragged from the Device Kits window. To make working with drivers views (but also device 

and point views) easier iSMA Tool filters Components available to use in Device Kits window, 

leaving only the ones, which can be added to the particular view. The picture below shows 

open ‘Driver Manager’ view with a list of available Components in Device Kits window. The list 

of components has been limited to those, which define networks, e.g. ModbusAsyncNetwork, 

ModbusTCPNetwork, ModbusTcpSlaveNetwork, OneWireNetwork, localIO, etc. The picture 

below shows the process of adding a driver ‘ModbusAsyncNetwork’ to Driver Manager view. 
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Next stage is to perform the necessary settings for the added network. It is best to use Object 

Properties window, which shows parameters of the added driver after it has been selected, 

see the picture below. Often, among the settings necessary for a network, is the need to turn 

it on, which can be done using the ‘enable’ button in the upper part of Object Properties 

window. 
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WARNING! Inactive ‘disable’ drivers are marked with gray color, see picture below. 

 

 

 

Segment 2 

 

Next, it is necessary to add to ‘ModbusAsyncNetwork’ the devices, which are part of that 

network. To do it, the added network(driver) needs to be double-clicked to open ‘Modbus Async 

Device Manager’” view and drag the Components representing device types installed in this 

network. The picture below shows the situation during dragging of the Component 

representing the ‘iSMADevice’ type device.  

 

iSMA Tool makes the process of finding the proper device among Components in Device Kits 

window easier by proper filtering of devices, which support the selected communications 

network (ModbusAsync), in the example below the devices are: ‘ModbusDevice’ and 

‘iSMADevice’. 
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After adding the device it is possible to name it differently than the default name given by iSMA 

Tool, such as ‘Mini4U4O’ and configure the device in Object Properties window, see picture 

below. 

 

 

 

WARNING! Inactive devices are indicated by gray color, as shown in the picture below. To 

activate a device, the ‘Enabled’ Slot needs to be set to ‘True’ using the Object Properties 

window, as shown in the picture above. 
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Remember: Red color indicates faulty devices with ‘Fault’ status, see picture below. 

 

 

 

 

Segment 3 

 

Next stage is adding points to the defined device, so the application of our controller will be 

able to read and record data from/to external device. 

For this purpose view ‘Modbus Async iSMA Module Point Manager’ needs to be opened by 

double-clicking the freshly added device. This time as well the Component list in Device Kits 

is limited to those, which cooperate with the selected device. Besides typical read and write 

points (here Components with “N” and “B” icons), there is also a Component of another type 

‘ModulesFolder’, see the selected folder on the picture below. 

 

ModulesFolder’ is a folder (container) allowing grouping of points. It may be used nested in 

the third segment views any number of times. Picture below shows the process of adding 

‘UI_Temp’ point under Mini4U4O device. 
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WARNING! To determine under what device the particular data point is, or what network it 

belongs to, you just need to look at the access path (picture below) shown above the Main 

window in the upper part of the screen, or at the Workspace Tree. 

 

 

 

 

The last stage will be determining the parameters required for each of the points separately, 

e.g. the address using Object Properties Window. 
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WARNING! Red color indicates faulty points with ‘Fault’ status, see picture below. 

 

 

 

After successful determination of point parameters, its device and network in which the device 

works, the current value should be able to be read. 

The process described above needs to be performed repeatedly for every network, every 

device in network and all required points.  

Next chapter describes the method to define custom tabular views based on the construction 

of predefined configuration xml files for drivers views. 

 

22.3 Creating custom Tabular views  

iSMA Tool allows defining the view contents as well as compatible (fitting) Components 

through proper xml file configuration. This approach allows iSMA Tool User to build required 

views for any type of Component in application.  

 

Xml configuration files need to be placed in iSMA Tool main folder under 

/home/CustomTableViews folder. 

By default the folder includes the following files created for tabular drivers views: 

• one ‘drivers.xml’ file – defining all drivers (networks) available in iSMA Tool, 

• many ‘[driver name]DeviceManager.xml’ or ‘[driver name]NetworkManager.xml’ files – 
defining the look for a particular driver (device) view, 

• many files of the type: ‘[Driver name]PointManager.xml’– defining the look of network 
points for a particular device.  
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Xml files have the following tags, whose meaning is necessary for proper construction of any 

tabular views. Below you will find descriptions of tags included in xml files along with 

examples of drivers views: 

 

• <ViewName>Driver Manager</ViewName> – defines the name of the view connected 
to the settings in remaining tags 

 

• <ForComponentTypes> – defines names of Components, for which the particular 
view will be used. This means that for Components defined within this tag, one of the 
assigned views will be a view defined by <ViewName> tag 

 

• <FilterComponents> – defines names of Components, which will appear in a table on 
the defined view and limits the number of Components shown in Device Kits window 

 

 

• <Columns> – a group of settings allowing to read particular Slots from Components 
assigned to particular view along with the name replacing the name of the Slot 
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Below you will find descriptions of actions that need to be taken to extend the offered tabular 

drivers views with custom networks, devices and points. The following actions need to be 

taken: 

• In ‘drivers.xml’ file extend the list <FilterComponents> with Component type 

defining new network (driver) unless such network has already been entered. 

• Duplicate any existing ‘……DeviceManager.xml’ file to define the devices view and 
optionally change file name  

• Open newly created file, change the name of the view under the tag <ViewName> and 
properly edit the definition inside the tags: <ForComponentTypes>, 
<FilterComponents> and <Columns> 

• Duplicate any existing ‘……PointManager.xml’ file to define the points view for a 
particular device and optionally change file name  

• Open newly created file, change the name of the view under the tag <ViewName> and 
properly edit the definition inside the tags: <ForComponentTypes>, 
<FilterComponents> and <Columns> 

• Close and restart iSMA Tool, because iSMA Tool checks drivers views definition only 
on startup. 

WARNING! A thorough description of tags is also available in ‘drivers.xml’ file. Getting to know 

it will allow proper configuration of this and other xml files. 

WARNING! iSMA Tool reads all xml configuration files for tabular views only during startup 

and if an error is found in xml file syntax, it will display a proper information in Console. 
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23 Keyboard Shortcuts List 

 

Shortcut Description 

Ctrl + N New Workspace (creates new workspace on Workspace Tree) 

Ctrl + O Opens a dialog window to choose a *.itw file saved earlier (Workspace) 

Ctrl + S 
Save changes in Workspace Tree window tree to a defined workspace in *.itw 

file. Does not apply to saving data in controller. 

Ctrl + Q Exiting iSMA Tool with confirmation of the intent to leave. 

Ctrl + C Copying of the selected Components. 

Ctrl + V Pasting of the Components copied with (Ctrl + C) option.  

Ctrl + D 
Duplication of selected Components. The option does not overwrite what 

was remembered during (Ctrl + C) copying. 

Delete Removal of selected elements (Component and/or Links). 

Ctrl or Shift 
The keys allow to select Components and Links selectively. Ctrl adds the 

chosen element, and Shift defines a set of added elements. 

Ctrl + N Create new Workspace Tree window for new projects 

F Rescale all Components on Wire Sheet view to see the all on the screen 

Ctrl + mouse wheel Zoom Wire Sheet in/out 

Ctrl + A Select all objects on active view 

F11 Hide/show all other windows to make main screen as large as possible 

F12 Restore previous windows position and size before used F11 option  

Ctrl + Tab Change focus to next window within opened windows in iSMA Tool 

Ctrl + Shift + Tab Change focus to previous window within opened windows in iSMA Tool 

Tab Navigate to the next object in current tree or list 

Shift +Tab Navigate to the previous object in current tree or list 
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PageUp/ 
PageDown 

Jump to the first/last object in current tree or list 

Ctrl + F Use filter on active view 

F2 Rename selected object 

F10 
Change focus to the main menu with a possibility to navigate between menu 

items 

Ctrl + P Print/export current view (option not available on all views) 

Ctrl + Left/Right Expand/collapse the tree 

Esc Cancel current settings 

Enter Accept current settings 

Alt + F4 Exits iSMA Tool with prompt popup 

Ctrl + Z Undo previous action on components 

Ctrl + Y Redo previously undone action on components 

Alt + Left/Right Navigate view history 

Alt + Shift + 
Left/Right 

Show view history flyout panel 

 

 


